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CHAPTER 1

Ultimate GDPR & CCPA Plugin

1.1 General Information

Thank you for purchasing Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA)
Plugin! We’re very pleased that you have chosen our plugin to extend your website. We’re doing our best not to
disappoint you! Before you get started, please check out these documentation pages. Ultimate General Data Protection
Regulation (Ultimate GDPR & CCPA) can only be used with WordPress and we assume that you already have it
installed and ready to go. If you don’t, please see WordPress Codex to get started.

1.2 Requirements

Before using Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA), please meet
the following requirements:

* Essentials to run WordPress — Read more about WordPress Minimum Requirements — in case any doubts re-
garding the server, contact your host provider.

* Latest version of WordPress, which you can download here.

¢ Create secure FTP and Database.

1.3 Installation

In our guide, we will show you step by step instructions on how to install our plugin. Below you will find two ways
how to install a WordPress plugin.

1.3.1 Installation via Administration Panel

If Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA) files are downloaded from
your Themeforest account, you can start an installation using WordPress administration panel.

¢ Step 1 - Once you’ve logged in to your administration panel, go to My Sites > Network Admin.



https://wordpress.org/support/article/how-to-install-wordpress/
http://wordpress.org/about/requirements/
https://wordpress.org/download/
https://codex.wordpress.org/FTP_Clients
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e Step 2 - Then click on Plugins > Add New, you will be directed to a page where you can choose available
themes.

@ Dashboard Dashboard

Home
Right Mow
Updates

Upgrade Network

Installed Plugins

Editor

* Step 3 - Once directed to the page, on the upper left side of the screen click on Upload Plugin button.
* Step 4 - Choose the ct-ultimate-gdpr.zip file from your computer, then click Install Now.

3

If you have a plugin in a .zip format, you may install it by uploading it here.

4

Choose File | No file chosen
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» Step S - After this, you will see the success message with a link to activate the plugin or return to plugin installer.

Installing Plugin from uploaded file
Unpacking the package...
Installing the plugin...

Plugin installed successfully.

Network Activate Return to Plugin Installer

Common Install Error: Are You Sure You Want To Do This?

If you get the following question message when installing ct-ultimate-gdpr.zip file via WordPress, it means
that you have an upload file size limit. Install the theme via FTP or call your hosting company and ask
them to increase the limit.

1.3.2 Installation via FTP
To install Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA) via FTP, follow
steps below:

 Step 1 — Unarchive ct-ultimate-gdpr.zip file

» Step 2 — Access your host web server using FTP client

 Step 3 - Find directory wp-content > plugins

¢ Step 4 — Put folder Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA) in
directory wp-content > plugins

Ijlwp—mriig—sarﬂe
I Jwp-cron
Elwp-lir'ks—nplrl

[~ wpoad

| I PN

Learn more:

¢ WordPress Codex — FTP clients

1.3. Installation 3
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1.4 Support

All of our items comes with free support. Free support is limited to questions regarding the themes features or
problems. We provide premium support for code customisation or third-party plugins.

Note: Our support hours: 10:00 AM - 6:00 PM UTC +1 on Monday to Friday.

1.4.1 Standard Support Support

For issues and concerns, you can reach us through these support methods:
¢ E-mail — support@createit.pl

* Help Desk — Click here to go to our support website. Just click on the Submit Ticket button and follow instruc-
tions to create a ticket.

¢ Forum — Comment/Post on the product you have issues/queries in ThemeForest or CodeCanyon websites.
Before You Post in a Forum

We urge you to follow the steps below, before you post a new topic on the forum, to speed up your
request. It’s in everyone’s interest and will benefit in making the entire forum more efficient:

— Step 1 — Always check the Documentation and the Knowledgebase Section. Most questions are
already answered in those areas.

— Step 2 — If your question hasn’t been brought up on the forum, please post a new topic. Always
be as specific as possible. Creating a topic requires entering the live URL to your home page or
page that shows the issue in question. It also has bars for WP and FTP login info, which aren’t
required, however, providing us with your login information can save a lot of time for both of
us. Login credentials are securely stored and accessible only by our support staff.

— Step 3 — We usually answer questions in 24 hours on working days. However, if you don’t get
any answer within 72 hours bump up your question or send us an e-mail.

For all support methods, you will receive confirmations and replies on your queries through e-mail or by tracking your
ticket which you will also get through e-mail. To track your ticket, please click here.

Once we reply to your query, each ticket will be open for 7 days without a reply from you. On the 6th day without a
reply, an e-mail will be sent to notify you of the ticket’s inactivity. To make the ticket active again, you simply need to
reply or follow the steps in the e-mail. If you won’t make the ticket active within 7 days, on the 8th day the ticket will
automatically be closed.

1.4.2 Premium Support
We can create your website from scratch, redesign it or just extend the current ones. For more information, please take
a look at our website. Typical issues covered by Premium Support:

e Custom CSS

* Support for third party software and plug-ins

* WordPress Installation with Theme configuration

* Server configuration

¢ Site structure modifications

4 Chapter 1. Ultimate GDPR & CCPA Plugin
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* Graphic adjustments, etc.
* WordPress general howto’s

» Shopify general howto’s

1.4. Support 5



Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

6 Chapter 1. Ultimate GDPR & CCPA Plugin



CHAPTER 2

How to

2.1 Activation

To activate the Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA), follow these
steps:

* Step 1 - In your wordpress dashboard, navigate to Plugins.
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e Step 2 - Locate the Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA)

from the list of plugins. Click on Activate, then wait for the plugin to load and activate.

(] Utimate GDPR & CCPA

Complete General Data Protection Regulation compliance toolkit plugin for WordPress,

Version 2.0 | By CreatelT

e Step 3 - Once Ultimate GDPR & CCPA Compliance Toolkit for WordPress (Ultimate GDPR & CCPA) is acti-

vated, you will see Ultimate GDPR & CCPA in the dashboard.
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Users
Tools
Settings

Custom Fields

Ultimate GDPR. &
CCPA

Loco Translate

© collapse menu

* Step 4 - You can now use the plugin.

2.2 Use and Features

Note: Before using this plugin, please read the explanation for the use of this plugin in:
* European Commission — Data Protection
¢ Original Consilium Europa Regulation document

* GDPR INFO

GDPR standardizes data protection law across all 28 EU countries and imposes strict new rules on controlling and
processing personally identifiable information (PII). From 25 May 2018 every website collecting data from EU citizens
must need the GDPR requirements.

Use and its Features are as follows:

In your wordpress dashboard, navigate to GDPR & CCPA:

2.2. Use and Features 9
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2.2.1 Ultimate GDPR

Ultimate GDPR & CCPA

Settings

Introduction Compatibility

The GDPR was approved and adopted by the EU Parliament in April 2016. The regulation will take effect afier a two-year transition peried and, unlike a Directive it does not
require any enabling legislation to be passed by government; meaning it will be in force May 2018.

The GDPR not only applies to organisations located within the EU but it will also apply to organisations located outside of the EU if they offer goods or services to, or monitor the
behaviour of, EU data subjects. It applies to all companies processing and holding the personal data of data subjects residing in the European Union, regardless of the company's
location.

This plugin will create a form where users can request access to or deletion of their personal data, stored on your website. It is also possible to:

1. Create a custom cookie notice and block all cookies until cookie consent is given.

2. Set up redirects for your Terms and Conditions and Privacy Policy pages until consent is given
3. Browse user reguests for data accessideletion and set custom email nofifications.

4. Send custom email informing about data breach to all users which left their email at your site.
5. Automatically add consent boxes for various forms on your website.

&. Pzeudonymize some of user data stored in database.

7. Check currenfly activated plugins for GDPR compliance.

To =tart, browse through setfings. Then, creale a new page with shortcode: [ultimate_gdpr_myaccount]

Available Shortcodes System Requirements:
User Settings: [ultimate_gdpr_myaccount] PHP Version: 5.4+
Privacy Policy Button: [ultimate_gdpr_policy_accepf] Memary Limit- 64 MB
Terms and Conditions [ultimate_gdpr_terms_accept] Disk Space: 10 MB
Button:
Cookie Popup Link- [ultimate_gdpr_cookie_popup]Link

[ultimate_gdpr_cookie_popup]
Display Cookies List: [render_cookies_list]
Protect Content: [ultimate_gdpr_protection level=4]

content

[/ultimate_gdpr_protection]

Privacy Center: [ultimate_gdpr_center myaccount_page=15
contact_page=18 icon_color=#e03131]

License

Envato key

Introduction

— This will show a summary of the use and purpose of GDPR & CCPA and features of the GDPR
& CCPA Plugin.

Available Shortcodes

— Shortcodes that can be used to show features of GDPR & CCPA.

System Requirements

— System requirements for the plugin to work.

Forms skin

Export/import options

— Export Plugin Settings - Export current plugin settings into a file. It can be imported to another
website with GDPR & CCPA plugin.

2.2. Use and Features 11
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— Import Plugin Settings - Import a file that have GDPR & CCPA plugin settings. The current
setting of the GDPR & CCPA plugin will be overwritten.

— Export Services - Export services from service manager.

— Import Services to Service Manager- Import a file that has services saved.

12 Chapter 2. How to
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2.2.2 Cookie Consent

Ultimate GDPR & CCPA

Settings

Cookie popup Preferences Advanced settings

Cookie popup content

Fill in with default content for selected language (remember to save changes)
an v
Cookie popup content
87 Add Media

Visual Text

== Pt (w!

L
[a]r
lils
%

Paragraph + B I = i &6

Cookies
To make this site work properly, we sometimes place small data files called
cookies on vour device. Most big websites do this too.

Buttons labels

Cookie popup 'accept’ button label Accept
(leave empty for default)

Cookie popup 'read more’ button label Read mare
({leave empty for default)

Cookie popup 'change settings’ button Cookies Settings
label (leave empty for default)

2.2. Use and Features 13
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Cookie popup Tab

¢ Cookie popup content

— Fill in with default content for selected language (remember to save changes) - Translate the default
contents in the plugin. Only the default contents are translated, if you have changed any of the text content
it will not be translated.

— Cookie popup content - What text content is shown inside the alert box of the cookie notice.
* Buttons labels

— Cookie popup ‘accept’ button label (leave empty for default) - Text content inside the accept button of
the cookie consent popup.

— Cookie popup ‘read more’ button label (leave empty for default) - Text content inside the read more
button of the cookie consent popup.

— Cookie popup ‘change settings’ button label (leave empty for default) - Text content inside the change
settings button of the cookie consent popup.

¢ Options

Display cookie popup on all pages - Option to display cookie notice on all pages if not accepted.

Check if user is from European Union - Option to allow only users that open/view your site from the
European Union touse the GDPR features.

Select page where to display the cookie popup - Where cookie notice will display if Display cookie
notice on all pages is not activated.

Do not block user agents (eg. bots) containing the following texts (comma separated)
¢ Google Analytics Tracking ID

— Google Analytics Tracking ID (disable tracking for this ID when cookies consent not given), eg.
UA-118586768-1

14 Chapter 2. How to
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Preferences Tab

Cookie popup Preferences

Cookie scanner settings

Choose how often cookie scans should
be performed

Choose default level of new cookies

Cookies whitelist (never block these
cookies, comma separated)

Block selected/all cookies until user
consents

Set consent expire time [s]

Buttons styles

Button settings by

Button shape

Button size

Button text color

Button background color

Ruttnn hnrdar rolor

Advanced settings

‘ Never v ‘

‘ Essential " ‘

[PH PSESSID, wordpress, wp-settings-,
__cfduid, ct-ultimate-gdpr-cookie

£

31536000 |
‘ Icon and Text v ‘
‘ Rounded ~ ‘
‘ Normal v ‘
‘ Select Color ‘

. Select Color

Position of the cookie m

Pasition (bottom, top and fu

Distance from border [px]

Cookie notice box

Box style

Box shape

Background color

Background image

Text color

Protection shortcode

Protection shortcode label

Custom style CSS

Custom style CSS

* Cookie scanner settings

— Choose how often cookie cans should be performed - Set when scan for cookies will be scheduled to be

done.

— Choose default level of new cookies - The default cookie level of the new cookies that are detected in the

site.

— Cookies whitelist (never block these cookies, comma separated) - Cookies that are not blocked even
when all cookies are blocked. This is used so that the cookies for accepting cookie consent is recorded.

2.2. Use and Features
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— Block selected/all cookies until user consents - Option to block all cookies until the user clicked the
accept button in the cookie notice.

— Set consent expire time [s] - Time, in seconds, when the cookie notice is still visible.
* Buttons styles
— Button shape - Shape of the buttons in the cookie consent popup.
— Button size - Size of the buttons in the cookie consent popup.
— Button text color - Text color of the text in the button.
— Button background color - Background color of the buttons in the cookie consent popup.
— Button border color - Color for the border of the button.
* Read more
— Read more page - The page where the READ MORE button will redirect.
— Read More Custom URL - URL link for the Read More page that is not in the site.
* My account disclaimer

— My account disclaimer - Information set by default: Removal of your data will not limit in any way the
system functionalities.

* Position of the cookie notice box
— Position - Location where the cookie notice will show.
— Distance from border [px] - Distance in pixels of the cookie notice from the border of the page.
* Cookie notice box
— Box style - Box style of the cookie consent popup.

+ Classic

Cookies To make this site work properly, we sometimes place small data files called cookies on your device. Most big websites do this too.

% Classic Dark

Cookies To make this site work properly, we sometimes place small data files called cookies on your device: Most big websites do this too.

Read more %

x Classic Light

+ Modern

16 Chapter 2. How to
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Listing ID Category Property Type Listing Type

Cookies To make this site work properly, we sometimes place small data files called cookies on your device. Most big websites do this too.

‘ Accept ‘ ‘ Cookies Settings | | Read more

And Many more!

Box shape - Shape of the box for cookie consent popup.

Background color - Background color of the cookie notice.

Background image -

websites do this too.

Text color - Font color of the text in the cookie notice.

* Protection shortcode
— Protection shortcode label
¢ Custom style CSS
— Custom style CSS - Custom CSS style for the cookie popup.

Advanced settings Tab

Note: For the Advanced Cookie Group popup to show, Use advanced cookie groups popup should be enabled.

Use advanced cockie groups popup Disable

* Trigger cookie

Trigger cookie settings by - Option on how the trigger for the advanced cookie setting is shown. With 3
choices: Text Only, Icon Only, or Icon and Text

Trigger cookie settings icon - Used for Icon Only or Icon and Text only. Choose an icon to use for the
trigger.

Trigger cookie settings text - Used for Text Only or Icon and Text only. Add the text to show for the
trigger.

Trigger cookie settings background color - Background color for the trigger.

Trigger cookie settings shape - Shape of trigger’s container.

Trigger cookie settings position - Location of the trigger for the advanced cookie setting.

Trigger cookie settings color - Color for the trigger for the advanced cookie setting.

2.2. Use and Features 17
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£+ Trigger

* Modal styles

— Cookie modal header color - Text color of the cookie modal’s header.

— Cookie modal text color - Text color of the cookie modal.

PRIVACY SETTINGS X

Decide which cockies you want to allow. You can change these settings at any time. Howevear, this can result in some
functions no longer being available. For information on deleting the cookies, please consult your browser’s help function.

Learn more about the cookies we use,

WITH THE SLIDER, YOU CAN ENABLE OR DISABLE DIFFERENT TYPES OF
COOKIES:

%,

Cookie Modal Heade&

Elock all Essentials Funcrionality Analytics Advertising
.

THIS WEBSITE WILL THIS WEBSITE WON'T
Essential: Remember your cookie permission setting Analytics: Keep track of your visited pages and
Essential: Allow session cockies interaction taken
Essential: Gather information you input into a contact Analytics: Keep track about your location and region
forms newsleter and other forms across all pages based on your IP number

tial: Keep track of what you inputin shopping Analytics: Keep track on the time spent on each page

cart Analytics: Increase the data quality of the statistics
Essential: Authenticate that you are logged into your functicns
user account Advertising: Tailer information and advertising
Essential: Remember language version you selected interests based on e.g, the content you have visited
Functionality: Remember social media settings befare, (Currently we do not use targeting or targeting
Functicnality: Remember selected region and country cookies)

Advertising: Gather personally identifiable informaticn

such as name and location

Cookie Modal

¢ Advanced cookie

— Show advanced cookie popup always, even when the consent is given - Option to display cookie notice
on all pages even if accepted.

— Use advanced cookie groups popup - Option to show “Change Settings” in the cookie popup.
— Advanced cookie groups popup header content - Text written at the header of the cookie modal.

¢ Lists of features

— List of features available for Essential level (comma separated) - Text that will show on the left side
for Essential level of the cookie groups popup under This Website will.

18 Chapter 2. How to
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List of features not available for Essential level (comma separated) - Text that will show on the right
side for Essential level of the cookie groups popup under This Website won’t.

List of features available for Functionality level (comma separated) - Text that will show on the left
side for Functionality level of the cookie groups popup under This Website will.

List of features not available for Functionality level (comma separated) - Text that will show on the
right side for Functionality level of the cookie groups popup under This Website won’t.

List of features available for Analytics level (comma separated) - Text that will show on the left side
for Analytics level of the cookie groups popup under This Website will.

List of features not available for Analytics level (comma separated) - Text that will show on the right
side for Analytics level of the cookie groups popup under This Website won’t.

List of features available for Advertising level (comma separated) - Text that will show on the left side
for Advertising level of the cookie groups popup under This Website will.

List of features not available for Advertising level (comma separated) - Text that will show on the right
side for Advertising level of the cookie groups popup under This Website won’t.

¢ Labels

This website will label - Label for the left portion of the cookie modal header.
This website won’t label - Label for the right portion of the cookie modal header.
Block all label - Label below the first icon in cookie modal.

Essentials label - Label below the second icon in cookie modal.

Functionality label - Label below the third icon in cookie modal.

Analytics label - Label below the fourth icon in cookie modal.

Advertising label - Label below the fifth icon in cookie modal.

¢ Additional settings

Hide “Block All” level features - Hides the option “Block All” in the cookie group settings.

Hide “Essential” level features - Hides the option “Essential” in the cookie group settings.

Hide “Functionality” level features - Hides the option “Functionality” in the cookie group settings.
Hide “Analytics” level features - Hides the option “Analytics” in the cookie group settings.

Hide “Advertising” level features - Hides the option “Advertising” in the cookie group settings.
Advanced cookie popup ‘save & close’ button label (leave empty for default) -

Select default privacy group - Set the default privacy group in the cookie popup settings..

Reload page when user saves changes - Option to have the page reload after user saves changes.

2.2,
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Advanced cookie groups popup header content

PRIVACY SETTINGS

Decide which cookies you want to allow. You can change these settings at any time. However, this can resultin some functions
no longer being available. For information on deleting the cookies, please consult your browser's help function. Learn more

about the cookies we use

WITH THE SLIDER, YOU CAN ENABLE OR DISABLE DIFFERENT TYPES OF

COQOKIES:

%) v 5% <

Labels Al = -

¥
Block all Essentials Functionality Analytics Advertising
0
THIS WEBSITE WILL THIS WEBSITE WON'T
Essential: Remember your cookie permission seiting Analytics: Keep track of your visited pages and
Essential: Allow session cookies interaction taken
Essential: Gather information you input into & contact Analytics: Keep track about your location and region
forms newsletter and other forms across all pages based on your IP number
Essential: Keep track of what you inputin shopping Analytics: Keep track on the time spent on each page
cart Analytics: Increase the data quality of the statistics
Essential: Authenticate that you are logged into your functions
USer account Advertising: Tailor information and advertising to your
Essential: Remember language version you selected interests based on .g. the content you have visited
Functicnality: Remamber social media sertings before. (Currently we do not use targeting or targeting
Functionality: Remember selected region and country cookies)
Advertising: Gather personally identfiable information
such as name and location

* SAVE & CLOSE
List of features -

» Save Changes - Button to save all the added/changed details in Cookie Consent.

* Download consents log - Button for the admin to download the consent logs of cookie consents. The down-
loaded file will be in a .txt format.

* Scan for cookies - Clicking this button will scan the site of the cookies that are used.

2.2.3 Services Manager

This is where the cookies that are detected are saved. You can change the cookies’s details here. You can also make a
customized cookie to be blocked from your site.

20 Chapter 2. How to
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Enter title here

1D

Service name

Script names

Please input comma separated names of cookie creating scripts

Cookie names

Please input comma separated cookie names

Type of cookie

Essential ¥

First or Third party?

Can be blocked?

Session or Persistent?

Expiry Time

Purpose

Do you want to activate this service?

* Title - Used only for admin user to navigate through services.

¢ Service name - Name of the service which will be displayed in table created using [ren-

2.2. Use and Features
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der_cookies_list] shortcode.

¢ Script names - Comma separated names of java-script scripts which are to be blocked, to prevent
creation of unwanted cookies.

* Cookie names - Comma separated names of cookies which are to be blocked. It’s important use
actual name of cookie, not name of service.

* Type of cookie - Pick the group the cookies belong.

« First or Third party? - Option to choose if the cookie is created by the site or by a 3rd party.
* Can be blocked? - Option for the cookie to be blocked.

* Session or Persistent? - If cookie is deleted when session ends, or if it has set expiry date.

* Expiry Time - Fill only if cookie is Persistent.

* Purpose - Purpose of the cookie.

 Is active? - Option to activate or deactivate. Only services which are active, are being blocked.

What Cookies are used on your website

Note: Functionality available since version 1.4

You can render the table with all cookies collected by your website with simple shortcode: [render_cookies_list]

Active cookies will be displayed in a table, like the following:

Cookie names Type of cookie  Firstor Third party Session or Persistent  Expiry Time Purpose
__cfduid Advertising persistent 23 May 2019 12:06:07
Advertising session

tawkUUID Advertising persistent 19 Nov 2018 12:06:07

NID Advertising persistent 22 Nov 2012 12:06:00

__utma, _utmb, __utme, _utms, _utmz, _ga, _gat, _gid Analytics third_party

act, wd, xs, datr, sb, presence, c_user, fr, pl, reg_ext_ref, reg fb_gate, reg fb_ref  Advertising third_party

krn_ai, ken_lv, km_vs, __atuvs, _atuve, uvc Functionality third_party

Note: Your website should be publicly accessible to correctly detect all cookies that are used on it

2.2.4 Age Verification

Age verification popup comes with number of predefined skins, we can also set skin to “none” and use custom color
and styling. You can all settings access via Ultimate GDPR > Age Verification
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Ultimate GDPR &t
CCPA

Cookie Cot sent

Services M nager

Age Verification

Ultimate G JPR & CCPA
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Age verification popup Tab

Age verification popup Preferences

Popup content

FPopup title | Age verification
Age popup content 07 Add Media Visual — Text

Paragraph *+ B I = &

3

o)
é = = B

Verify your age

Popup 'Submit’ button label ' Accept

Options

Block user agents (eg. bots)
containing the following texts
{comma separated)

Popup content:
* Popup title — Text content presented as a title of the box of the age popup

* Age popup content — Text content inside the box of the age popup
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* Popup ‘Submit’ button label — Text content inside the accept button of the age verification popup.

Popup title

Age verification

Verify your age

Options

Block user agenis (eg. bots) | |
containing the following texts
(comma separated)

Lower age limit to enter the | 19 |
website )
Lower age limit to provide personal | 19 |
data '
Default age select placeholder | July 31, 2020 |

Enter age value to assume if age | |
not yet entered

Options

* Do not block user agents (eg. bots) containing the following texts (comma separated) - You can see the bot
database here

* Lower age limit to enter the website — The lowest age which will allow user to access the website
* Lower age limit to provide personal data - The lowest age which will allow user to provide personal data

* Default age select placeholder — default age which will be presented in the Age Verification placeholder

2.2. Use and Features 25



Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

* Enter age value to assume if age not yet entered - will blocks cookies assuming this age when user will not
entered age yet

Options

Enable Age Verification Enabled Disabl

)
[at]
[=y
[1¢]

Display the popup on all pages Enabled

Check if user is from California Enabled = I

w
k]
[=}
9]

)
i
[at]
(=2
[11]

Select page where to display the -
popup Front page

Posts page

Youtube

wp form

Wideo - small

Wideo - Full Sreen

Typography

Toggables

This is the page!

Testimonials

Terms and Condition

Team

Shop testimonial test

Polariod -

Select 'my account' page (one to -
redirect to when user is underage, Front page

eg. show link on registration form) Posts page

Youtube

wp form

Video - small

Video - Full Sreen

Typography

Toggables

This is the pagel

Testimonials

Terms and Condition

Team

Shop testimonial test

Polariod -

Note: Always set page in the Select ‘my account’ to fully block user from browsing the website without age confir-
mation.

Options
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* Enable Age Verification — Enable the Age Verification popup
* Display the popup on all pages — Enable the Age Verification on all of the pages of the website

¢ Check if user is from California — When this option is enabled only users from California will see the Age
Verification popup

* Select page where to display the popup - Where cookie notice will display if Display cookie notice on all
pages is not activated.

¢ Select ‘my account’ page (one to redirect to when user is underage, eg. show link on registration form) —
User will be redirected to this page if the provided age will be lower than the one set in the ‘Lower age limit to
enter the website’

» Save Changes — Clicking this button will save all the made changes.
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Preferences Tab

Expiration time

Set age verification expire time [3]

Position of the age popup

Position (bottom, top and full page
layout)

Distance from border [px]

Buttons styles

Button shape

Button background color

Button text color

Age verification popup Preferences

31536000

| Bottom panel

| 20

| Rounded

. Select Colour

| Select Colour

Expiration time

» Set age verification expire time [s] — After this time the verification will expire

Position of the age popup

* Position (bottom, top and full page layout) — Choose the position of the age popup. Available position are:

— Bottom left
— Bottom right

— Bottom panel
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Top left

Top right

Top panel

Full page layout
* Distance from border [px] — Set the distance from the border. By default it is set to 20px.

Button styles

Note: This option work only for the Box style: none which can be set in the Ultimate GDPR & CCPA > Preferences
> Popup box — Box style

* Button shape — There are two types of button shapes available
— Rounded
— Squared
* Button background color — Allow admin to choose the color of the button.
* Button text color — Allow admin to choose the color of the button
Popup box
* Box style - Box style of the cookie consent popup.

— Red Velvet

Age verification

September

— Thin Mint
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Age verification

Verify your age

September

— Mint Chocolate

Age verification

Verify your age

— Classic createlT

Age verification

Verify your age

September

— Blueberry with Orange
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Age verification

Verify your age

September 2010

— Blue Velvet

Age verification

Verify your age

.

— Matcha

Age verification

Verify your age

— Classic Dark
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Age verification

Verify your age

September

— Classic Light
Age verification
Verify your age
September
— Oreo

Age verification

Verify your age

September

— Blue Shortbread
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Age verification

Verify your age

September b o

— Light Mint

Age verification

Verify your age

— Blue Cupcake

Age verification

Verify your age

September 12 2010 Accept

— Matcha
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Age verification

Verify your age

September v

— Mint

Age verification

Verify your age

n“

— None (example

Age verification

— Box shape- Shape of the buttons in the age verification popup.
— Background color - Background color of the age verification box.
— Background image — Background image which can be set as a part of the background

— Text color - Text color of the text in the button.
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Custom style CSS
¢ Custom style CSS - Custom CSS style for the Age verification popup.

2.2.5 Terms and Conditions

Here you will set a page as the Terms and Conditions page, set conditions, and set the page where to redirect.

Terms and Conditions

Instructions

shortcode on your existing Terms and Conditions page to add an accept butten
2. Select Terms and Conditions page below, so users can be redirected there to give their consent.

Require logged in users to accept Terms and Conditions (redirect) Enable Disabled

Require not logged in users/guests to accept Terms and Conditions (redirect) Enable

Page with existing Terms and Conditions v
Page to redirect to after Terms accepted Last visited page v
Shortcode Button Styling Theme Default v
Set consent expire time [s] 31536000

Terms version, eg. 1.0 (if you change it, user has to give consent again) 1.0

Convert the following text to Terms and Conditions link in all services templates, Terms and Conditions

eg. Terms and Conditions’

Do not block user agents (eg. bots) containing the following texts (comma
separated)

slurp, spider, mediapartners

Press "Save changes” before downloading logs if you changed any options

Download consents log

¢ Instructions - This is how to add a button for consent to accept the terms and condition on the page.

* Require logged in users to accept Terms and Conditions (redirect) - Option to have the users
logged in first to be able to accept the terms and conditions.

* Require not logged in guest to accept Terms and Conditions (redirect) - Option to allow non-
logged in users to accept the terms and conditions.

* Require not logged in users/guests to accept Privacy Policy (redirect) - Option to allow non-
logged in users and guests to accept the terms and conditions.
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* Page with existing Terms and Conditions - Select a page where the terms and conditions are
written.

* Page to redirect to after Terms accepted - The page where to redirect after terms and conditions
are accepted.

* Shortcode Button Styling - How the button for the shortcode looks. You have 2 options: Theme
Default or Cookie box buttons

¢ Set consent expire time [s] - Time, in seconds, when the terms and condition is still visible.

¢ Terms version, eg. 1.0 (if you change it, user has to give consent again) - The version of the terms
and conditions.

* Convert the following text to Terms and Conditions link in all services templates, eg. ‘Terms
and Conditions’ - You can make the word you set in the textbox as a link to the Terms and Condi-
tions page.

* Do not block user agents (eg. bots) containing the following texts (comma separated)

* Download consents log - Button for the admin to download the consent logs of terms and conditions.
The downloaded file will be in a .txt format.

Note: If Require logged in users to accept Terms and Condition is enabled, the user can’t be redirected to other
parts of the site until the user logs in and accepts the Terms and Conditions.

2.2.6 Privacy Policy

Here you will set a page as the Privacy Policy page, set conditions, and set the page where to redirect.
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Privacy Policy

Instructions

1. Place [ultimate_gdpr_policy_accepf] shortcods on youl
2. Sefect Privacy Policy page below, so users can be redirecsed

sting Privacy Policy pape to add an accept button
thers to give their consent.

Require dministrators to accept Privacy Pelicy [redirsct)
Requira logged in users to accept Privacy Policy (redirect)
Requirz not lkogged in users/guests to accept Privacy Policy (redirsct)

WordPress Privacy Policy page Click here to create

Page with existing Privacy Policy |

Privacy Policy Custom URL |

Open Privacy Policy in & naw Tab Enabled

Page to redirect to after Privacy Policy accepted | Last vizited page |

Shortcode Button Styfing

| Thams

Set consent expire time [5] | 31536000 |
Privacy Policy version, 2g. 1.0 (if you change it. user has to give conzent | 10 |
again)

Redirect te Privacy Policy first (if Terms and Conditions also redirect)

Convert the following text to Privacy Policy link in all services templates, eg.
‘Privacy Policy’

| Privacy Paolicy |

Do mot block user agents (2g. bots) containing the following texts {comma

| bot, crawl, slurp, spider, mediapartners |
separated]

Fress "Save chanpes” before downlosding logs i you changed any options

¢ Instructions - This is how to add a button for consent to accept the privacy policy on the page.

* Require logged in users to accept Privacy Policy (redirect) - Option to have the users logged in
first to be able to accept the privacy policy.

* Require not logged in guest to accept Privacy Policy (redirect) - Option to allow non-logged in
users to accept the privacy policy.

WordPress Privacy Policy page - Link to create or use the default privacy policy of wordpress.

* Page with existing Privacy Policy - Select a page where the privacy policy are written.

Privacy Policy Custom URL - URL link for the Privacy Policy that is not in the site.

Open Privacy Policy in a new Tab - Enable/Disable to show the Privacy policy in new tab.

Page to redirect to after Privacy Policy accepted - The page where to redirect after privacy policy
are accepted.
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» Shortcode Button Styling - How the button for the shortcode looks. You have 2 options: Theme
Default or Cookie box buttons

* Set consent expire time [s] - Time, in seconds, when the privacy policy is still visible.

¢ Privacy Policy version, eg. 1.0 (if you change it, user has to give consent again) - The version of
the privacy policy.

* Redirect to Privacy Policy first (if Terms and Conditions also redirect) - Option to show privacy
policy first when user opens the site.

* Convert the following text to Privacy Policy link in all services templates, eg. ‘Privacy Policy’ -
* Do not block user agents (eg. bots) containing the following texts (comma separated)

* Download consents log - Button for the admin to download the consent logs of privacy policy. The
downloaded file will be in a .txt format.

Note: If Require logged in users to accept Privacy Policy is enabled, the user can’t be redirected to other parts of
the site until the user logs in and accepts the Privacy Policy.

2.2.7 Right to be Forgotten

Here you can set details for when users request for deletion of stored data.

Right To Be Forgotten Data Access Data Breach Data Rectification
Forms skin
Skin Rounded form v
Right to be forgotten settings
Automatically forget users who
confirmed their mail
Permit users of selected roles only 2dministratar
to be forgotten automatically Editor
Author
Admin email to send new reguest
netifications to
User netification emal suject Uttimate GDPR] Your data has been forgotten
User notification email message N
ual fext
aragraph B I =E=ZHMMEZELE-E
[Ultimate GDPR] Your data has been forgotten
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* Admin email to send new request notifications to - Where the email for the request is sent.
* User notification email subject - Title of the Email sent for the request.
 User notification email message - Content of the Email that is sent for the request.

* Set custom URL to page containing Ultimate GDPR & CCPA shortcode for e-mail confirma-
tions (or leave empty for autodetect) - URL link to the page for e-mail confirmation.

* [bbPress] Enter the existing user’s email whom the posts will be reassigned to (or leave empty
to delete them when forgetting) - Email for whom the posts will be re assigned to.

* Right To Be Forgotten requests list - List of users that sent the request.

This is the front end form:

PERSONAL DATA ACCESS FORGET ME DATA RECTIFICATION

Below you can browse services which collect your personal data on this website. Check services you wish to be forgotten by. This will send
a request to website admin. You will be notified by e-mail once this is done.

WP Comments
WordPress Comments are data entered by users in comments

WordPress Posts
WordPress posts author data

WP User Data

WordPress user data stored as user meta data in database

Email:

I consent to my email being collected in order to process this request. See Privacy Policy page for more information.

SUBMIT

In the front end form, the user can choose which personal data on the site can be forgotten. With this, an email request
will be sent to the website admin once the request is Submitted.

Note: The email that the user enters in the form is the email where the user will get his reply or notification for the
request.

This is an sample Email for the request:
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= [Ultimate GDPR] Please confirm request to be forgotten from boilerplate
0d  WordPress Data Dzisiaj 15:44
To confirm, please follow this link: http://ctll.pinkv.createit/boilerplate/ultimste-gdpr/2e=p.szmelterfddcreateit.plgh=cfOfbEb3Sagi=ct-ultinate-gdor-forgotten

Note: To add the front end form on a page, create a page and add this shortcode : [ultimate_gdpr_myaccount]

2.2.8 Data Access

Here you can set details for when users request for data access.

Data access settings

Email to send new request notifications to

Mail title [Ultimate GDPR] Data request results from Estato WordPress Theme
Mail content 7 Add Media viensl T
Paragraph ¥ B I i E €6 = = = £ = =X = W

Please find data attached

Save Changes

Data access requests list

User ID Email Date of request Date of data sent Select for action See details

Send data to selected emails Remove selected requests from list || Remove all sent requests from list

Email to send new requests notifications to - Where the email for the request is sent.
* Mail title - Title of the Email sent for the request.

* Mail content - Content of the Email that is sent for the request.

* Data access requests list - List of users that sent the request.

This is the front end form:
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PERSONAL DATA ACCESS FORGET ME DATA RECTIFICATION
Below you can request having your personal data collected by this website sent to you in an e-mail.

Email:

I consent to my email being collected in order to receive my requested data. See Privacy Policy page for more information.

Note: The email that the user enters in the form is the email where the user will get his reply or notification for the
request.

This is an sample Email for the request:

b [Ultimate GDPR] Data request results from FoodTruck 4| |@w| = fim]
0d WordPress Data Dzisiaj 20:16 -

Please find data attached
google_analytics-BuKyp0.js... =

woocommerce-GPNr6f.json ... =
wp_comments-IcODS3.json... ~
wp_posts-ziBRU4.json (~6... -

wp_user-cLn3l5.json (11 ... -

G

all-services-Fwtdhp.txt (r7... =

Pobierz wszystkie jako ZIP

Note: To add the front end form on a page, create a page and add this shortcode : [ultimate_gdpr_myaccount]

2.2.9 Data Breach

Here you can set details for when there is a data breach in the site. An email will be sent informing about data breach
to all users which left their email at your site.
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Data Breach

Mail title [Ultimate GDPR] Data breach information from Estato WordPress Theme
Mail content 1 Add Media Visual ~ Text
Paragraph vB I = £ ¢ = £ = @ = = 1]

There was a data breach on our page...

Collect user emails from services

ARForms Enable Disabled

Gravity Forms Enable Disabled

Mailster Enable Disabled

WooCommerce Enable Disabled

WP User Data Enable Disabled

WP Simple Paypal Shopping Cart Enable Disabled

Press 'Save changes' before sending emails if you changed any options

Go to send emails screen

* Mail title - Title of the Email sent for the request.

* Mail content - Content of the Email that is sent for the request.
¢ Collect user emails from services - Option to collect emails form the following plugins if enabled.
— ARForms
— Gravity Forms
— Mailster
— Woocommerce
— WP User data
— WP Simple Paypal Shopping Cart

2.2.10 Data Rectification

Here you can set details for when users request for data rectification.
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Data Rectification settings

Email to send admin notifications to
User mail title

User mail content

Set custom URL to page containing Ultimate
GDPR shortcode as the e-mail confirmation
target page (or leave empty for autodetect)

Save Changes

Data rectification requests list

User ID Email

[Ultimate GDPR] Data rectification notice from Estato WordPress Theme

0 Add Media

Paragraph

(w]

Your data has been rectified

Date of request

Visua
B I = = ¢ = = = & = =
Date of data ) )
Select for action See details

sent

EENGIGEIEROETE T LI ET | Remove selected requests from list Remove all sent requests from list

Text

* Email to send admin notifications to - Where the email for the request is sent.

» User Mail title - Title of the Email sent for the request.

* User Mail content - Content of the Email that is sent for the request.

¢ Set custom URL to page containing Ultimate GDPR & CCPA shortcode as the e-mail confir-

mation target page (or leave empty for autodetect)

* Data rectification requests list - List of users that sent the request.

This is the front end form:
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PERSONAL DATA ACCESS FORGET ME DATA RECTIFICATION

Below you can send a request for website admin to rectify your data. Enter what you would like to be rectified. You will be notified by e-
mail once this is done.

Current data

Rectified data

Email:

I consent to my email being collected in order to process this request. See Privacy Policy page for more information.

The data the user adds in the Current data text area will be overridden/replaced by the data the user adds in Rectified
data text area. Once submitted, an email will be sent to the site admin to notify him of the request.

An email to notify the user that the request is accepted will be sent once the admin of the site selected the email of the
user he would like to approve the request and clicked on Send data to selected emails button.

Note: The email that the user enters in the form is the email where the user will get his reply or notification for the
request.

2.2.11 Unsubscribe

Option to delete user’s data on their requested service once the user confirmed their email.
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Unsubscribe settings

Set custom URL to the page
ing Ultimate GDPR
rtcode as the emai
confirmation ta
empty for autodet:

ge (or leave

Enter custom subheader for
Unzubscribe’ tab in ‘my account’
de (or leave empty for
default content)

Unsubscribe request list

Autcmatically unsubscribe users Enabled

wiho confirmed their mail

Automatically send email about Enabled

unsubscription to users who

confirmed their mail

Email to s2nd admin netifications

o

User mail titlz

User mail content O3 Add Mediz Visual  Text
Parzgaph + B I E E @ E = £ £ = = E 8-

User ID Emai

Email user / remove request

Hide Unsubscribe Tab - This option hide the Unsubscribe tab of the GDPR & CCPA shortcode.

Automatically unsubscribe users who confirmed their mail - Option to automatically unsubscribe

the user without admin confirmation once the user confirmed their email.

Automatically send email about unsubscription to users who confirmed their email - Option to

automatically send an email about the unsubscription once the user confirmed their email.
Email to send admin notifications to - Where the email for the request is sent.
User Mail title - Title of the Email sent for the request.

User Mail content - Content of the Email that is sent for the request.
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¢ Set custom URL to page containing Ultimate GDPR & CCPA shortcode as the e-mail confir-
mation target page (or leave empty for autodetect)

 Data rectification requests list - List of users that sent the request.

* Enter custom subheader for ‘Unsubscribe’ tab in ‘my account’ shortcode (or leave empty for
default content)

A confirmation email will be sent to the user’s email to confirm the request to unsubscribe to this service.

Note: The email that the user enters in the form is the email where the user will get his reply or notification for the
request.

This is an sample Email for the confirmation:

v [Ultimate GDPR] Please confirm request to be unsubscribed from... oty = =
0d  ultimate GDPR Plugin Demo Data Dzisiaj 21:27 -
To confirm, please follow this link: https://www.createit.pl/gdpr/gdpr/2e=

ultimate-gdpr-unsubscribe

2.2.12 Services

A checkbox for consent can be added at the first field or at the last field of the form. These options can be added to the
Services that gathers personal information from users.

46 Chapter 2. How to



Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

Services options

R icha key (for |
submissions) S

Recaptcha secret key (for myaccount |

shoricode submissions)

When logging consents of usars who did Enable
not accept Privacy Policy, log their IP

m

When logging consents of users who did Enable
not accept Privacy Policy, log their User

Agent

Addthis -
ARForms -
[bbPress] Name [bbPress 4
[bbPress] Description bbPress gathers users activity in forums

~
[bbPress] Inject consent checkbox to all Enable
forms -
[bbPress] Hide from Forget Me Form Enable
BuddyPress -
Caldera Forms. -

Services options

¢ Recaptcha key (for myaccount shortcode submissions) - Used to add reCAPTCHA to your site.

¢ Recaptcha secret key (for myaccount shortcode submissions) - Used for communication between
your site and Google. Be sure to keep it a secret.

Note: To create a new Google reCAPTCHA for your site, click on this link.

* When logging consents of users who did not accept Privacy Policy, log their IP - This feature
will work when “When logging consents of users who did not accept Privacy Policy, log their IP” is
activated. The IP of the user will be shown with the user id and time of consent.

* When logging consents of users who did not accept Privacy Policy, log their User Agent - This
feature will work when “When logging consents of users who did not accept Privacy Policy, log
their User Agent” is activated. The browser and computer details of the user will be shown with the
user id and time of consent.

Addthis:

¢ [Addthis] Block Addthis cookies when user doesn’t accept Functionality cookies - Option to block Addthis
cookies if Functionality cookie level is not set.
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ARForms:

* [ARForms] Inject consent checkbox to all forms - Option to add consent check box in all pages with AR-
Forms.

* [ARForms] Hide from Forget Me Form - This function is not applicable for this plugin

bbPress:

[bbPress] Name - What is shown in the Forget Me Form as the bbPress’s name.

[bbPress] Description - What is shown in the Forget Me Form to describe bbPress.

[bbPress] Inject consent checkbox to all forms - Option to add consent check box in all pages with bbPress.

[bbPress] Hide from Forget Me Form - Option to hide it from Forget Me Form.

BuddyPress:

[BuddyPress] Name - What is shown in the Forget Me Form as the BuddyPress’s name.

[BuddyPress] Description - What is shown in the page to describe the BuddyPress.

[BuddyPress] Inject consent checkbox to all forms - Option to add consent check box in all pages with
BuddyPress.

[BuddyPress] Hide from Forget Me Form - Option to hide it from Forget Me Form.

Calendar Form:

* [Calendar Form] Name - What is shown in the Forget Me Form as the Calendar Form’s name.
e [Calendar Form] Description - What is shown in the page to describe the Calendar Form.

 [Calendar Form] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Calendar Form.

* [Calendar Form] Hide from Forget Me Form - Option to hide it from Forget Me Form.

Contact Form CFDB7:

¢ [Contact Form CFDB7] Name - What is shown in the Forget Me Form as the Contact Form CFDB7’s name.
* [Contact Form CFDB7] Description - What is shown in the page to describe the Contact Form CFDB7.
* [Contact Form CFDB7] Hide from Forget Me Form - Option to hide it from Forget Me Form.

WPForms Lite:

* [WPForms Lite] Inject consent checkbox to all forms - Option to add consent check box in all pages with
WPForms Lite.

* [WPForms Lite] Hide from Forget Me Form - This function is not applicable for this plugin.
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Contact Form 7:

¢ [Contact Form 7] Name - What is shown in the Forget Me Form as the Contact Form 7’s name.
* [Contact Form 7] Description - What is shown in the page to describe the Contact Form 7.

* [Contact Form 7] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Contact Form 7.

¢ [Contact Form 7] Inject consent checkbox as the first field instead of the last - Option to add the consent
checkbox at the first field in the Contact Form 7.

* [GDPR Accepted] Filter for Email sent at the bottom of contact form 7 - By default (no text added) the
option is deactivated. With added text (for example: “GDPR ACCEPTED:”). This option will add the custom
text + GDPR Accepted date at the end of the send message.

* [Contact Form 7] Hide from Forget Me Form - This function is not applicable for this plugin.

Waitlist for WooCommerce - Back In Stock Notifier
¢ [Waitlist for WooCommerce - Back In Stock Notifier] Name - What is shown in the Forget Me Form as the
Waitlist for WooCommerce - Back In Stock Notifier’s name.

* [Waitlist for WooCommerce - Back In Stock Notifier] Description - What is shown in the page to describe
the Waitlist for WooCommerce - Back In Stock Notifier.

¢ [Waitlist for WooCommerce - Back In Stock Notifier] Inject consent checkbox to all forms - Option to add
consent check box in all pages with Waitlist for WooCommerce - Back In Stock Notifier.

* [Waitlist for WooCommerce - Back In Stock Notifier] Display consent checkbox for logged in user - Option
to add consent check box in all pages with Waitlist for WooCommerce - Back In Stock Notifier ONLY for logged
in users.

* [Waitlist for WooCommerce - Back In Stock Notifier] Hide from Forget Me Form - Option to hide it from
Forget Me Form.

Custom Facebook Feed:

* [Custom Facebook Feed] Hide from Forget Me Form - This function is not applicable for this plugin.

eForm - WordPress Form Builder:
* [eForm - WordPress Form Builder] Name - What is shown in the Forget Me Form as the eForm - WordPress
Form Builder’s name.

* [eForm - WordPress Form Builder] Description - What is shown in the page to describe the eForm - Word-
Press Form Builder.

* [eForm - WordPress Form Builder] Inject consent checkbox to all forms - Option to add consent check box
in all pages with eForm - WordPress Form Builder.

* [eForm - WordPress Form Builder] Hide from Forget Me Form - Option to hide it from Forget Me Form.
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Events Manager:

* [Events Manager] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Events Manager.

* [Events Manager] Hide from Forget Me Form - This function is not applicable for this plugin.
Flamingo:

 [Flamingo] Name - What is shown in the Forget Me Form as the Flamingo’s name.

 [Flamingo] Description - What is shown in the page to describe the Flamingo.

* [Flamingo] Hide from Forget Me Form - This function is not applicable for this plugin.
Formcraft:

e [Formcraft] Name - What is shown in the Forget Me Form as the Formcraft’s name.

[Formcraft] Description - What is shown in the page to describe the Formcraft.

[Formcraft] Inject consent checkbox to all forms (Premium) - Option to add consent check box in all pages
with Formcraft Premium version.

* [Formcraft] Inject consent checkbox to all forms (Basic) - Option to add consent check box in all pages with
Formcraft Basic version.

[Formcraft] Hide from Forget Me Form - Hide from Forget Me Form -** Option to hide it from Forget Me
Form.

Formidable Forms:

* [Formidable Forms] Name - What is shown in the Forget Me Form as the Formidable Forms’ name.
* [Formidable Forms] Description - What is shown in the page to describe the Formidable Forms.

¢ [Formidable Forms] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Formidable Forms.

[Formidable Forms] Inject consent checkbox as the first field instead of the last - Option to add the consent
checkbox at the first field in the Formidable Forms.

[Formidable Forms] Hide from Forget Me Form - Hide from Forget Me Form -** Option to hide it from
Forget Me Form.

Gravity Forms:
* [Gravity Forms] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Gravity Forms.

* [Gravity Forms] Inject consent checkbox as the first field instead of the last - Option to add the consent
checkbox at the first field in the Gravity Forms.

* [Gravity Forms] Hide from Forget Me Form - This function is not applicable for this plugin.
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Klaviyo:

* [Klaviyo] Inject consent checkbox to all forms - Option to add consent check box in all pages with Klaviyo.

* [Klaviyo] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Mailchimp:

¢ [Mailchimp] Inject consent checkbox to order fields - Option to add consent check box in all pages with
Mailchimp.

¢ [Mailchimp] Inject consent checkbox as the first field instead of the last - Option to add the consent checkbox
at the first field in the Mailchimp.

¢ [Mailchimp] Inject Hide from Forget Me Form - This function is not applicable for this plugin.
Mailerlite:

* [Mailerlites] Inject consent checkbox to all forms - Option to add consent check box in all pages with Mail-
erlite.

* [Mailerlites] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Mailpoet:
* [Mailpoet] Inject consent checkbox to all forms - Option to add consent check box in all pages with Mailerlite.
* [Mailpoet] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Mailster:

e [Mailster] Name - What is shown in the Forget Me Form as the Mailster’s name.

[Mailster] Description - What is shown in the page to describe the Mailster.

e [Mailster] Inject consent checkbox to all forms - Option to add consent check box in all pages with Mailster.

[Mailster] Inject consent checkbox as the first field instead of the last - Option to add the consent checkbox
at the first field in the Mailster.

[Mailster] Inject consent checkbox to unsubscribe forms - Option to add the consent checkbox in all Mail-
ster’s unsubscribe forms.

[Mailster] Hide from Forget Me Form - Hide from Forget Me Form -** Option to hide it from Forget Me
Form.

Metorik Helper:

¢ [Metorik Helper] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Metorik Helper.

¢ [Metorik Helper] Inject Hide from Forget Me Form - This function is not applicable for this plugin.
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Newsletter:
* [Newsletter] Inject consent checkbox to all forms - Option to add consent check box in all pages with Newslet-
ter.

* [Newsletter] Inject consent checkbox as the first field instead of the last - Option to add the consent checkbox
at the first field in the Newsletter.

 [Newsletter] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Ninja-Forms:

* [Ninja-Forms] Name - What is shown in the Forget Me Form as the Ninja-Forms’ name.
¢ [Ninja-Forms] Description - What is shown in the page to describe the Ninja-Forms.

* [Ninja-Forms] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Ninja-Forms.

¢ [Ninja-Forms] Inject Hide from Forget Me Form - Hide from Forget Me Form -** Option to hide it from
Forget Me Form.

Quform:

* [Quform] Name - What is shown in the Forget Me Form as the Quform’s name.
* [Quform] Description - What is shown in the page to describe the Quform.
* [Quform] Inject consent checkbox to all forms - Option to add consent check box in all pages with Quform.

* [Quform] Inject consent checkbox as the first field instead of the last - Option to add the consent checkbox
at the first field in the Quform.

[Quform] Inject Hide from Forget Me Form - Hide from Forget Me Form -** Option to hide it from Forget
Me Form.

Ultimate Member:
¢ [Ultimate Member] Inject consent checkbox to all forms - Option to add consent check box in all pages with
Ultimate Member.

* [Ninja-Forms] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Woocommerce:

* [Woocommerce] Description - What is shown in the page to describe the Woocommerce.

* [Woocommerce] Inject consent checkbox to order fields - Option to add consent check box in all pages with
Woocommerce.

* [Woocommerce] Inject consent checkbox to account forms - Option to add consent checkbox in Woocom-
merce register form.

* [Woocommerce] Inject consent checkbox to checkout - Option to add consent checkbox in Woocommerce
checkout page.

¢ [Woocommerce] Additional checkout consent label - Text added here will be shown in the additional consent
checkbox.
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* [Woocommerce] Inject additional consent checkbox to checkout - Option to add consent check box in check-
out page (this consent isn’t required to be accepted by the user).

* [Woocommerce] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Wordfence:

* [Wordfence] Block Wordfence cookies when a user doesn’t accept Functionality cookies

* [Wordfence] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

WP Comments:

[WP Comments] Name - What is shown in the Forget Me Form as the WP Comments’s name.
¢ [WP Comments] Description - What is shown in the page to describe the WP Comments.

* [WP Comments] Inject consent checkbox to comments fields - Option to add consent check box in all pages
with WP Comments.

[WP Comments] Hide from Forget Me Form - Option to hide it from Forget Me Form.

wpForo:

* [wpForo] Name - What is shown in the Forget Me Form as the wpForo’s name.
e [wpForo] Description - What is shown in the page to describe the WP Comments.
 [wpForo] Inject consent checkbox to all forms - Option to add consent check box in all pages with wpForo.

e [wpForo] Hide from Forget Me Form - Option to hide it from Forget Me Form.

WP Job Manager:

* [WP Job Manager] Name - What is shown in the Forget Me Form as the WP Job Manager’s name.
* [WP Job Manager] Description - What is shown in the page to describe the WP Job Manager.
* [WP Job Manager] Hide from Forget Me Form - Option to hide it from Forget Me Form.

WordPress Posts:

* [WordPress Posts] Name - What is shown in the Forget Me Form as the WordPress Posts’s name.
* [WordPress Posts] Description - What is shown in the page to describe the WordPress Posts.

* [WordPress Posts] Hide from Forget Me Form - Option to hide it from Forget Me Form.

WP User data:

e [WP User data] Name - What is shown in the Forget Me Form as the WP User data’s name.
* [WP User data] Description - What is shown in the page to describe the WP User data.
e [WP User] Inject consent checkbox to User network signup form fields

¢ [WP User] Inject consent checkbox to User register form fields
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¢ [WP User] Inject consent checkbox to lost password form fields

* [WP User] Hide from Forget Me Form - Option to hide it from Forget Me Form.

YITH Woocommerce Wishlist:
e [YITH Woocommerce Wishlist] Name - What is shown in the Forget Me Form as the YITH Woocommerce
Wishlist’s name.

¢ [YITH Woocommerce Wishlist] Description - What is shown in the page to describe YITH Woocommerce
Wishlist.

e [YITH Woocommerce Wishlist] Hide from Forget Me Form - Option to hide it from Forget Me Form.

Youtube:

¢ [Youtube] Remove youtube iframes until Necessary cookies accepted

* [Youtube] Inject Hide from Forget Me Form - This function is not applicable for this plugin.

Note: If you would like to add the checkbox for consent in a different place than the one provided by the GDPR &
CCPA Plugin, click on this link for a sample on how to do it. The sample is using Contact Form 7 but you can do this
with other forms.

This is how it would look on the page.

PERSONAL DATA ACCESS FORGET ME DATA RECTIFICATION

Below you can browse services which collect your personal data on this website. Check services you wish to be forgotten by. This will send a request to website admin. You
will be notified by e-mail once this is done.

Events Manager
Events Manager gathers data entered by users in booking order forms

WP Comments
WordPress Comments are data entered by users in comments

WordPress Posts
‘WordPress pests author data

WP User Data
WordPress user data stored as user meta data in database

Email:

| consent to my email being collected in order to process this request. See Privacy Policy page for more information.

SUBMIT
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Mame

First Last

Email

Subject

Message

Consent *

| consent to the storage of my data according to the

Submit

2.2.13 Pseudonymization

Here you can set which information are encrypted.
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Pseudonymization

Warning

This featura is experimental and may lead 10 irreversible data lost! After encryption, it may be impossible for anyone to decrypt your data.

Instructions

some of the dats stored in the database. T

yone Zot sccess o
LEL

en accessed by use permanently | your contents

r continuous encryption of all incoming data

cted 1 encrypt all current data which has not been yet encrypred

Automatically encrypt new data Enable Disabled

Automatically decrypt all data on the fiy {if you have anything Enable Disabled

encrypted, this is recommended)

Select data to encrypt

[WeooCommerce] Pseudonymize first and last name Enable Disabled

[WeoCemmerce] Pseudonymize address infermation Enable Disabled

[WeooCommerce] Pseudonymize billing ema Enable Disabled

[WP User Data] Pseudonymize first and last name Enable Disabled

[WP Simple Paypal Shopping Cart] Pseudonymize user order data Enable Disabled

Press 'Save changes' before pressing encryption buttons if you changed

 options

database, the user's data would be pseudonymized. Database

Warning: This feature is experimental and may lead to irreversible data lost! After
encryption, it may be impossible for anyone to decrypt your data. Read Instructions first,
before setting the encryption.

* Automatically encrypt new data - Option to automatically encrypt new data inputted in the site.

¢ Automatically decrypt all data on the fly (if you have anything encrypted, this is recommended) - Option

to automatically decrypt all data inputted in the site to the database.

* Select data to encrypt - Select which data are encrypted in the site.

llSil’lg woocommerce.

llSiI’lg woocommerce.

merce.

WP user data.

[Woocommerce] Pseudonymize first and last name - Option to encrypt the first and last name when

[Woocommerce] Pseudonymize address information - Option to encrypt the address information when

[Woocommerce] Pseudonymize billing email - Option to encrypt the billing email when using woocom-

[WP User data] Pseudonymize first and last name - Option to encrypt the first and last name when using

[WP Simple Paypal Shopping Cart] Pseudonymize user order data - Option to encrypt the user order
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data when using WP Simple Paypal Shopping Cart.

2.2.14 Plugins

Here you can see which plugins are compatible with the GDPR & CCPA plugin.

Plugin Collects user data Compatible with Ultimate GDPR
Contact Form 7 Yes Yes
Ultimate GDPR Yes Yes
WooCommerce Yes Yes
Polylang Probably No
Custom Sidebars Probably Ne
WPL Probably No
Estato Plugin Unknown No
WPEBakery Page Builder Unknown No
Loce Translate Unknown No
Max Mega Menu Unknown No
slider Revalution Unknown No
Preloader Unknown No

2.3 Add to Page

These are samples on how to add the Ultimate GDPR & CCPA features and shortcodes.

2.3.1 Cookie Consent

Note: The plugin can check if the user viewing your site is from European Union by going to Ultimate GDPR &
CCPA > Cookie Consent and activating/checking Check if user is from European Union.

Users that are not from the European Union will not be able to see Ultimate GDPR & CCPA features.
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Cookie popup 'read more'
button label (leave empty for
default)

Cookie popup 'change
settings’ button label (leave
empty for default)

Display cookie popup on all
pages

Read mors

Cookies Settings

Check if user is from European
Union

Select page where to display
the cookie popup

Wiy PR OTS pays
Media Sections
Maintenance

Live admin demao
Lists Simple

Latest Listing

ron hoves

To add a cookie consent on the site, in your dashboard go to Ultimate GDPR & CCPA > Cookie Consent.

You will be redirected to the Cookie consent settings.
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Ultimate GDPR & CCPA

Settings

Cookie popup Preferences

Cookie popup content

an

Cookie popup content

07 Add Media

Paragraph ~ B I =

in
| ]
[ o

Coolkies

Buttons labels

Cockie popup 'accept’ button label
{leave empty for default)

Cockie popup 'read more” button label
{leave empty for default)

Cockie popup 'change settings' button
label (leave empty for default)

Advanced settings

Fill in with default content for selacted language (remember to save changes)

Wisual

P = = Iw]

cookies on vour device. Most big websites do this too.

Accept

Read mors

Cookies Settings

T

Text

To make this site work properly, we sometimes place small data files called

2.3. Add to Page
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In Select pages to display cookie notice on, choose a page on your site that you will like to show the cookie notice.

Note: Display cookie notice on all pages if activated, will let you show the cookie notice in all pages until it is
accepted.

Add the needed information and details. For more details on Cookie consent settings, click here.

Note: Admin can download consent logs for admin to know what consent the user gave for Cookie Consent. You can
find the download button at the bottom of Ultimate GDPR & CCPA > Cookie Consent.

Google Analytics Tracking ID
(disable tracking for this ID
when cookies consent not
given), eg. UA-118586768-1

Save Changes

Download consents log

Detect cookies

Other Functions

¢ Set the Default Cookie Group

When the Change Settings button is clicked, it well show the Advance cookie setting and the Default
Cookie Group selected.

With the slider, you can enable or disable different types of cookies:

v <o =

Essentia Functionality Analytics Advertising

.

This website will: This website won't:

You can change the default cookie group in Ultimate GDPR & CCPA > Cookie Consent > Cookie
consent settings > Select default privacy group
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Use advanced cookie groups

v
popup
Select default privacy group Essential v
Block all
fEntelf (ust(;lv[(ook{e:l;lnames Functionality
for group ssential’ (comma Analytics

separated X
g ) Advertising

* Show Privacy Settings Trigger

1tocart
o
e @i
f/ );] i Ikl."._
Kx | l k] ,r :
LY
ODIE WITH HOODIE WITH
30 ZIPPER
.00 £45.00
1tocart Add to cart
SALE!
) , i
:.ﬁ\ [ 1r—\_\ |
IS 4p wool
ll :/ . M@@ i
- S s |
L— ™)
LO SINGLE
).00 £306£2.00
L
ito cart Add to cart

This Trigger will show the Advance cookie Settings even if it is already set. Users of the site can
change the Advance cookie setting anytime they want by just clicking on the icon.

You can show this trigger when the Show advanced cookie popup always, even when the consent
is given under Ultimate GDPR & CCPA > Cookie Consent > Advance settings tab is activated.
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Cookie popup Preferences Advanced settings

Advanced Cookies Settings

<hZ»Privatsphire-Einstellungen</h2>
<div class="ct-ultimste-gdpr-cookie-model-desc™>

Show advanced cookie popup always, Enabled Disable
event when the consent is given
Use advanced cookie groups popup Enabled Disable
Advanced cookie groups popup header content
Q) Add Media Visual = Text
b || /| link | b-quote || det || ins || img || ul || ol || i || code || more || closetags

<prEntscheiden 5ie, welche Cookies Sie zulassen michten.

2.3.2 Terms and Conditions

To add terms and conditions on the site, create a page where all the terms and conditions are written.

Add New Page

Terms and Condition

@  Backend Editor

@7 Add Media visual

Paragraph v

B I
“ — Av@E QO

2 m

1. General provisions

1. CreatelT sc. (“createIT”) provides a software solution (“GDPR Plugin”) as further specified on www.createit.pl/gdpr, that enables its customers to manage dynamic
discounts, client reward systems, reference and loyalty programs, dynamic promo badges as well as conditional cart discounts, in numeric and percentage values, in
‘web systems based on WordPress for WooCommeree. GDPR Plugin provides components to build weleome discounts for new users, storewide rule management,
conditional numeric & percentage discounts, client discount reward system, recommendation building system, time and category discount rules as well as dynamic
discount info display (the “Services”).

. All contractual relationships between createIT and any user using GDPR Plugin offered by createlT (a “Use:

P

, "Users") shall be governed by these Terms of Service
(the "Terms of Service"). By registering with GDPR Plugin's Website or using the GDPR Plugin, the User agrees to be bound by these Terms of Service.

3. The Service offerings of createlT are available to Business Clients (as defined below). For the purpose of these Terms of Service a “Business Client” is a User (whether
an individual, company or partnership vested with legal capacity) who enters into the relevant contract in the conduct of its business or its self-employed
professional activity in accordance with the provisions of law and these terms of service.

4. Standard business conditions and/or general terms and conditions of the User do not apply, regardless of whether or not ereateIT has expressly objected to them in a

particular case.

createlT may amend these Terms of service at any time upon observance of statutory regulations and notifving the Users about the amendment. In case the Terms of

service are amended, the User should accept their new wording, which shall apply to a renewed billing period. If the User does not accept the new wording of the

Terms of service, the Services shall cease to be provided with the end of a current billing period and the contract will terminate automatically.

o

2, Registration

1. Any use of the Serviees requires prior registration on the Website by creating an GDPR Plugin account and the acceptance of these Terms of Service. By clicking the
box “I agree to our Terms of Service and Privacy Policy” or by registering on the Website after createlT provides a link with these Terms of Services stating that they

P

Word count: 2509 Draft saved at 8:37:10 am.

Screen Options ¥

Publish a

Save Draft Preview
9 status: Draft Edit
@ Visibility: Public Edit

i) Publish immediately Edit

Move 1o Trash

Page Attributes s
Parent

(no parent) v

Template

Default Template M

Order

o

Need help? Use the Help tab above the
screen title.

Sidebars a
Here you can replace the default sidebars.
simply select what sidebar you want to
show for this post!

single product bottom column 1:

Single product bottom column 2:

Add the button to accept the terms and condition, add the shortcode: [ultimate_gdpr_terms_accept]
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Order
Paragraph v B T E = = = o
w — Av @ Q “ (7]
MNeed help? Use the Help tab above the
. screen title.
13. Miscellaneous

1. Any contracts entered into between createlTand a User shall be governed by the laws of the Philippines, without prejudice to any

Sidebars a
mandatory conflict of laws provisions.

2. If the User is a Business Client or if the User is a legal entity or a foreign special fund organized under public law, the common Here you can replace the default sidebars.
courts in Philippines, shall have exclusive jurisdiction in respect of all disputes arising out of or in connection with the relevant simply SE|S_“ what sidebar you want to
contract. show for this post!

3. Should any provision of this Terms of Service be or become invalid, ineffective or unenforceable as a whole or in part, the Single product bottom column 1:
validity, effectiveness and enforceability of the remaining provisions shall not be affected thereby. Any such invalid, ineffective or v
unenforceable provisions shall be deemed replaced by such valid, effective and enforceable provision as come closest to the
economic intent and purpose as of such invalid, ineffective or unenforceable provisions as regard subject-matter, amount, time, Single product bottom column 2:

place and extent. The aforesaid shall apply mutatis mutandis to any gap in these Terms of Service if any court has confirmed

such proceeding. Products Listing:

[ultimate_gdpr_terms_accept] Footer column 1:

p
Word count: 2509

Footer column 2:
Draft saved at 8:44:17 am.

Template settings i Footer column 3:

Show title:  use global settings v
Primary Sidebar:
Show page title?

Show breadcrumbs:  use global settings v

Show breadcrumbs? Featured Image .

After publishing the page for the terms and conditions, in your dashboard go to Ultimate GDPR & CCPA > Terms
and Conditions.

You will be redirected to the Terms and Conditions settings.
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Terms and Conditions

Instructions

1. Place [ultimate_gdpr_terms_accept] shortcode on your existing Terms and Conditions page to add an accept button.
2, Select Terms and Conditions page below, so users can be redirectad there to give their consent.

Require logged in users to accept Terms and Conditions (redirect) Enable Disabled

Require not logged in users/guests to accept Terms and Conditions (redirect) Enable Disabled

Page with existing Terms and Conditions v
Page to redirect to after Terms accepted Last visited page v
Shortcode Butten Styling Theme Default v

[¥%)
L
[ve)
o
=
=]
[=]

Set consent expire time [s]

Terms version, eg. 1.0 (if you change it, user has ta give consent again) 1.0

Convert the following text to Terms and Conditions link in all services templates,
eg. Terms and Conditions’

Terms and Conditions

Do not block user agents (eg. bots) containing the following texts (comma

bot, crawl, slurp, spider, mediapartners
separated)

Press "Save changes” before downloading logs if you changed any options

Save Changes

Download consents log

In Page with existing Terms and Conditions, choose the page that you made with the terms and conditions are written.

Add the needed information and details. For more details on Terms and Conditions, click here.

Note: Admin can download consent logs for admin to know what consent the user gave for Terms and Conditions.
You can find the download button at the bottom of Ultimate GDPR & CCPA > Terms and Conditions.
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Convert the following

text to Terms and

Conditions link in all Terms and Conditions
services templates, eqg.

‘Terms and Conditions’

Download consents log

2.3.3 Privacy Policy

To add privacy policy on the site, create a page where all the privacy policy are written.

TTEETUpTIO, e
Add New Page

Privacy Policy Publish .
P link: http://ct7.phinky.createit/sando/privacy-policy-2/ Edit Save Draft Preview

@  Backend Editor 9 status: Draft Edit

@& Visibility: Public Edit

@ Add Med
« edlz Visual  Text [iif] Publish immediately Edit

Paragraph Ad

B I
- - AvE Q

Move to Trash

2w
(]

. . Page Attributes a
‘What information do we collect? g
R R . B Parent
‘We at createlT sc. (createlT) collect information from yvou when vou register on our site or fill out a form.
‘When ordering or registering on our site, as appropriate, vou may be asked to enter your name, e-mail address, contact details as well (no parent) M
as address. Template
‘What do we use your information for? Default Template N
3 . ) . Order
Any of the information we collect from vou may be used in one of the following ways:
0
1. Your information helps us to better respond to your individual needs
. . . . . . . . Need help? Use the Help tab above the
2. We continually strive to improve our website offeringgs based on the information and feedback we received from you. ccreen m'\:e "
3. Your information helps us to more effectively respond to vour customer service request and support needs.
4. Your information, whether public or private, will not be sold, exchanged, transferred, or given to any other company for
any reason whatsoever, without your consent, other than for the express purpose of delivering the purchased product or Sidebars .

service requested by the customer.

5. The email address vou provide for order processing, may be used to send you information and updates pertaining to vour Here you can replace the default sidebars.

Simply select what sidebar you want to

order, in addition to receiving occasional company news, updates, related product or service information, ete. show for this post!

Single product bottom column 1:

Note: If at any time vou would like to unsubscribe from receiving future emails, we include detailed unsubscribe instructions at the
bottom of each email. Single product bottom column 2:

To add the button to accept the privacy policy, add the shortcode: [ultimate_gdpr_policy_accept]
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Paragrap! *+ B I &= =
W — AvE O QE BN
This policy was last modified on 2018-01-31.

Contacting Us

If there are any questions regarding this privacy policy yvou may contact us using the information below.

createlT sc

‘Wasiutynskiego 16
00-707 Warszawa
Poland

office@createit.pl
+48223783379
wwiw.createit.pl

[ultimate gdpr policy accept

[
Word count: 532

Template settings

Show title:  use global settings ¥
Show page title?
Show breadcrumbs:  use global settings ¥

Show breadcrumbs?

Draft saved at 9:09:59 am.

Order

0
Need help? Use the Help tab above the
screen title.

Sidebars a
Here you ca

Simply sele
show for this p

lace the default sidebars.
idebar you want to

0

Single product bottom column 1

Single product bottom column 2:

Products Listing:

Footer column 1:

Footer column 2:

Footer column 3:

Primary Sidebar:

Featured Image a

Set festured image

After publishing the page for the privacy policy, in your dashboard go to Ultimate GDPR & CCPA > Privacy Policy.

You will be redirected to the Privacy Policy settings.
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Privacy Policy

Instructions

1. Place [ultimate_gdpr_policy_accepf] shoricode on your existing Privacy Policy pape to add an accept button.
2. Selzct Privacy Polizy page below, 3o users can be redirectzd thers to give their consent.

Requira administrators to accept Privacy Policy (redirect) En

Require logged in users to accept Privacy Folicy (redirect) En

Requirz not kogged in users/guests to accept Privacy Pelicy (rediract)

WordPress Privacy Policy page Click here to create

Page with existing Privacy Policy |

Privacy Pelicy Custom URL |

Opan Privacy Policy in 2 new Tab Enabled Disab

Page to redirect to after Privacy Policy accepted | Last visited page |

Shortcode Button Styfing | Theme Default |
Set conzant axpirs time [5] | 31536000 |
Privacy Policy version, £g. 1.0 (if you change it. user has to give consent | 10 |

2gzin)

Redirect to Privacy Policy first (if Tarms and Conditions also redirect) Enable m

Convert the following text to Privacy Policy link in all services templates, eg.

o o | Erivacy Folicy |
Privacy Policy

Do mot block user agents (2g. bots) containing the following texts {comma

| bot, crawl, slurp, spider, medizpartners |
zzparatad]

Press "Save chanpes” before downloading legs # you changed any cofions

In Page with existing Privacy Policy, choose the page that you made with the privacy policy are written.

Add the needed information and details. For more details on Privacy Policy, click here.

Note: Admin can download consent logs for admin to know what consent the user gave for Privacy Policy. You can
find the download button at the bottom of Ultimate GDPR & CCPA > Privacy Policy.
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Convert the following

text to Privacy Policy

link in all services Privacy Policy
templates, eg. ‘Privacy

Policy’

Save Changes

Download consents log

2.3.4 Right To Be Forgotten

To add the Right to be Forgotten on your site, create a page where your want to show the Forget Me tab.

In the page you created, add the shortcode: [ultimate_gdpr_myaccount]

GDPR account Publish a
Permalink: hitp://ct7.phinky.createit/sando/gdpr-account/ Edit Praview Chanaes
[ ] Backend Editor 9 status: Published Edit
@@ Visibility: Public Edit
Q] Add Media .
= : Visual  Text fif] Published on: May 7, 2018 @ 07:52 Edit
Paragraph vB I £ £ ¢ = £ = & = [S]~ pad
- o Move to Trash
e — AvE QO QE T °
[ultimate_gdpr_mvaccount] Page Attributes -
Parent
(no parent) v
Template
Default Template v
Order
0
Meed help? Use the Help tab above the
screen title.
P
Wlmed mmaamds lLart mditmd s memmdmid ;e Bdaas T W0 o TET mmn

After publishing the page with the shortcode, in your dashboard go to Ultimate GDPR & CCPA > Right To Be
Forgotten.

You will be redirected to the Right to be forgotten settings.
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Right To Be Forgotten Data Access Data Breach Data Rectification
Forms skin
Skin Rounded form v

Right to be forgotten settings

Automatically forget users who

confirmed their mail o Disabled

Automatically send email about Enable Disabled
data removal to users who =

confirmed their email

Permit users of selected roles only Adrministrator -
to be forgotten automatically Editor

Author

Contributor

Subscriber

Customer

Shop manager

-

Admin email to send new request
notifications to
User notification email subject [Ultirmate GOPR] Your data has been forgotten
User notification email message ‘}: Add Media

Visual  Text

Formats v | Paragraph * B I =

1]
m
U0
Iih
%
Il
L]

[Ultimate GDPR] Your data has been forgotten

Add the needed information and details. For more details on Right To Be Forgotten settings, click here.

When a user sends a request, an email to confirm the request will be sent to the user.

IYour request was sent! I

PERSOMNAL DATA ACCESS

Below, you can request for your personal data that's collected by this website sent to you in an email.

Emall:

I consent to have my emall collected In order to recelve my requested data. See Privacy Policy page for more
Information.

2.3. Add to Page 69


http://gdpr-plugin.readthedocs.io/en/latest/Page/newPage.html#right-to-be-forgotten

Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

Depending on the option set in the Right to be forgotten settings:
¢ Automatically forget users who confirmed their mail is DISABLED

If the option Automatically unsubscribe users who confirmed their mail is disabled, the user must

confirm the request in the email first for the request to be posted in the Right To Be Forgotten
request list.

[Ultimate GDPR] Please confirm request to be forgotten from sa...
0d  WordPress Data Dzisiaj 20:22

low this link: http:// S s le/ gdpr/ o=

In the Right To Be Forgotten request list, the admin of the site have the option to approve or delete
the request.

Save Changes
Right To Be Forgotten request list
User ID Email ?e\vlces to -Cliget Date of request Date of mail sent Email user / remave
(user selected) request
Mot registered ] Select all 17 Aug 2018 Not sent
- 12:22:21

WP Comments

Forget and notify selected users Remove selected requests from list Remove all sent requests from list

If the admin approves the request, select the services to unsubscribe the user from (these services are
selected by the user for what services he would like to be forgotten). Then select the user you would

like to forget by selecting the check box below Email user / remove request, then click the Forget
and notify selected users button.

Right To Be Forgotten request list

§ Services to forget : R Email user / remove
User ID Email N v kJ Date of request Date of mail sent
(user selected) request
Not registered ] | Select all Not sent
L] /| WP Comments

Forget and notify selected users Remove selected requests from list Remove all sent requests from list

An email to notify the user that the request to be forgotten is approved.

[Ultimate GDPR] Your data has been forgotten

»  WordPress <wordpress (@ Sl -
. ® tome [+

[Ultimate GDPR] Your data has been forgottan

* Automatically forget users who confirmed their mail is ENABLED

If the option Automatically forget users who confirmed their mail is enabled, when the user con-

firm the request in the email the user will automatically be forgotten from the services the user have
selected without any admin intervention.
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Your request was successfully confirmed.

PERSONAL DATA ACCESS

Below, you can request for your personal data that's collected by this website sent to you in an email.

Email

I consent to have my emall collected In order to recelve my requested data. See Privacy Policy page for more
Information.

The user request will be posted in the Right To Be Forgotten request list.

If the option Automatically send email about data removal to users who confirmed their email
is enabled, once the user confirms the request in the email the user will receive an email to notify the
user for the request to be forgotten.

2.3.5 Data Access

To add the Data Access request on your site, create a page where your want to show the Personal Data Access tab.

In the page you created, add the shortcode: [ultimate_gdpr_myaccount]

GDPR account Publish a
Permalink: http://ct7.phinky.createit/sando/gdpr-account/ | Edit Preview Changes

[ ] Backend Editor 9 status: Published Edit

@@ Visibility: Public Edit

0 Add Media .
«] Add Visual  Text i Published on: May 7, 2018 @ 07:52 Edit

paragaph v B I i i =
- o Move to Trash
w — AviEoQE = )

i
-
-~
0
]l
hh

[ultimate_gdpr mvaccount] Page Attributes a

Parent

(no parent) v

Template

Default Template v

Order

0

Meed help? Use the Help tab above the
screen title.
4]

Wlmed memts 0 Lart meditnd ks mrmmbait mm e T W18 o8 TET mme

After publishing the page with the Data Access request, in your dashboard go to Ultimate GDPR & CCPA > Data
Access.
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You will be redirected to the Data access settings.

Data access settings

Email to send new request notifications to

Mail title [Ultimate GDPR] Data request results from Estato WordPress Theme
Mail content 7 Add Media Vool B
Paragraph r B I & E @ = = £ £ = = =W

Please find data attached

Save Changes

Data access requests list

User ID Email Date of request Date of data sent Select for action See details

Send data to selected emails Remove selected requests from list || Removwe all sent requests from list

Add the needed information and details. For more details on Data Access settings, click here.
When a user sends a request, it is posted in Data access requests list.

An email with data attached will be sent to the user once the admin of the site selected the email of the user he would
like to approve the request and clicked on Send data to selected emails button.

2.3.6 Data Rectification

To add the Data Rectification request on your site, create a page where your want to show the Data Rectification tab.

In the page you created, add the shortcode: [ultimate_gdpr_myaccount]
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GDPR account

Permalink: http://ct7.phinky.createit/sando/gdpr-account/ | Edit

@&  Backend Editor

Publish i
Preview Changes
9 status: Published Edit

@@ Visibility: Public Edit

07 Add Media .
- : Visual  Text i Published on: May 7, 2018 @ 07:52 Edit
paragraph v B I = £ 6 = = = pad
- __ B Move to Trash Update
w — AvEQ QE S %)
[ultimate_gdpr mvaccount] Page Attributes -
Parent
(no parent) v
Template
Default Template v
Order
0
Meed help? Use the Help tab above the
screen title.
P
Wlmed mmaamds lLart mditmd s memmdmid ;e Bdaas T W0 o TET mmn

After publishing the page with the Data Rectification, in your dashboard go to Ultimate GDPR & CCPA > Data

Rectification.

You will be redirected to the Data Rectification settings.

2.3. Add to Page
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Data Rectification settings
Email to send admin notifications to
User mail title [Ultimate GDPR] Data rectification notice from Estato WordPress Theme
i 09 a Ao .
User mail content 4] Add Media Ve Text
Paragraph B I = = ¢ = = = &£ = =
(wl
Your data has been rectified
Set custom URL to page containing Ultimate
GDPR shortcode as the e-mail confirmation
target page (or leave empty for autodetect)
Save Changes
Data rectification requests list
. . Date of data ) )
User 1D Email Date of request sent Select for action See details
Send data to selected emails Remove selected requests from list Remove all sent requests from list

Add the needed information and details. For more details on Data Rectification settings, click here.

When a user sends a request, an email to confirm the request will be sent to the user. The user must first confirm
the request before it is posted in Data rectification requests list.

An email to notify the user that the request is accepted will be sent once the admin of the site selected the email of
the user he would like to approve the request and clicked on Send data to selected emails button.

2.3.7 Unsubscribe

To add the Unsubscribe request on your site, create a page where your want to show the Unsubscription tab.

In the page you created, add the shortcode: [ultimate_gdpr_myaccount]
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GDPR account

Permalink: http://ct7.phinky.createit/sando/gdpr-account/ | Edit

@&  Backend Editor

Publish i
Preview Changes
9 status: Published Edit

@@ Visibility: Public Edit

07 Add Media .
- : Visual  Text i Published on: May 7, 2018 @ 07:52 Edit
paragraph v B I = £ 6 = = = pad
- __ B Move to Trash Update
w — AvEQ QE S %)
[ultimate_gdpr mvaccount] Page Attributes -
Parent
(no parent) v
Template
Default Template v
Order
0
Meed help? Use the Help tab above the
screen title.
P
Wlmed mmaamds lLart mditmd s memmdmid ;e Bdaas T W0 o TET mmn

After publishing the page with the Unsubscribe, in your dashboard go to Ultimate GDPR & CCPA > Unsubscribe.

You will be redirected to the Unsubscribe settings.

2.3. Add to Page
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Unsubscribe settings

Hide Unsubscribe Tab Enable

Automatically unsubscribe users m Diczhle
who confirmed their mail

Automatically send email about
unsubscription to users who
confirmed their mail

Email to s2nd admin netifications
o

User mail titlz

User mail content Oy Add Mediz Visual  Text

Paragraph  + B

[
1
"

-
N

n

I

Il

%

Il

o

]

wy
4

Set custom URL to the page
ining Ultimatz GOPR

smpty for autode

Enter custom subheader for
Unzubscribe’ tab in ‘my account’
shortcode (or leave empty for
default content)

Unsubscribe request list

User I Email SEI'\-|C:ES © .nsubsc.' o Data of raquest Data of mail sent Email user / remove request
from (user szlectad)

Add the needed information and details. For more details on Unsubscribe settings, click here.

When a user sends a request, an email to confirm the request will be sent to the user.
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IYour request was sent! I

PERSOMNAL DATA ACCESS

Below, you can request for your personal data that's collected by this website sent to you in an email.

Emall:

I consent to have my emall collected In order to recelve my requested data. See Privacy Policy page for more
Information.

Depending on the option set in the Unsubscribe settings:
¢ Automatically unsubscribe users who confirmed their mail is DISABLED

If the option Automatically unsubscribe users who confirmed their mail is disabled, the user must
confirm the request in the email first for the request to be posted in the Unsubscribe request list.

hi [ultimate GDPR] New Unsubscribe request | || = =
Od  WordPress Data Dzisiaj 14:17 -

There is & new Unsubscribe request from email UV S-c

http://ct7.phinky.createit/sample/wp-admin/admin.php?page=ct-ultimate-gdpr-unsu

In the Unsubscribe request list, the admin of the site have the option to approve or delete the request.

confirmation target page (or leave
empty for autodetect)

Save Changes

Unsubscribe request list

Services to
UserID Email unsubscribe from Date of request Date of mail sent
{user selected)

Email user / remove
request

Select all 17 Aug 2018 Not sent
06:15:17

Mailchimp

Unsubscribe and notify selected users Remove selected requests from list Remove all sent requests from list

If the admin approves the request, select the services to unsubscribe the user from (these services are
selected by the user for what services he would like to be unsubscribed). Then select the user you
would like to unsubscribe by selecting the check box below Email user / remove request, then click
the Unsubscribe and notify selected users button.
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Unsubscribe request list

senvices to Email user / remove
User ID Email unsubscribe from Date of request Date of mail sent e :
- - request
(user selected)
Mot registered ] v| Select all 17 Aug 2018 Not sent v
L] 08:15:17
| Mailchimp

Remove selected requests from list Remove all sent requests from list

| Unsubscribe and notify selected users

An email to notify the user that the request to unsubscribe is approved.

v [Ultimate GDPR] Unsubscribe notice from Ultimate GDPR Compliance Toolkit for WordPress
0d  Ultimate GDPR Plugin Demo Data  Dzisiaj 15:15

Your have been unsubscribed

¢ Automatically unsubscribe users who confirmed their mail is ENABLED

If the option Automatically unsubscribe users who confirmed their mail is enabled, when the user
confirm the request in the email the user will automatically be unsubscribe from the services the user
have selected without any admin intervention.

Your request was successfully confirmed.

PERSONAL DATA ACCESS

Below, you can request for your personal data that's collected by this website sent to you in an email.

Email

I consent to have my emall collected In order o recelve my requested data. See Privacy Policy page for more
Information.

The user request will be posted in the Unsubscribe request list.

If the option Automatically send email about unsubscription to users who confirmed their email
is enabled, once the user confirms the request in the email the user will receive an email to notify the
user for the unsubscription.

2.4 Cookies Management

2.4.1 Customize Cookie Popup

To customize the look and content of the cookie popup, go to Ultimate GDPR & CCPA > Cookie Consent > Cookie
popup Tab
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Cookie popup Preferences Advanced settings

Cookie popup content
Fill in with default content for selected language (remamber to save changes)

en

Load

Cookie popup content
7 Add Media Visual  Text

L E = EM

11}
"
-
-~
n
i
hh

Parsgraph ~ B I

Cookies
To make this site work properly, we sometimes place small data files called cookies on your device. Most big websites do this too.

Buttons labels Options

Cookie popup 'accept’ button label Accent Display cookie popup on all pages Disable |

(leave empty for default)

Cookie popup 'read more’ button label Read more i .
{leave empty for default) Check if user is from European Union Enahle Disabled
Cookie popup 'change settings’ button Cookies Settings
label (| for default
peesoer v el Select pages where to display the
cookie popup Front page
Posts page

* Cookie popup content - Details in the cookie popup that informs the user of its use.

* Cookie popup ‘accept’ button label (leave empty for default) - Label for the accept button.

¢ Cookie popup ‘read more’ button label (leave empty for default) - Label for the read more button.

* Cookie popup ‘change settings’ button label (leave empty for default) - Label for the cookie settings button.

* Display cookie popup on all pages - Option to display the cookie popup on all pages until consent is given.

2.4.2 Cookie Group Panel

User’s privacy settings (whether he accepts cookies or not, and what group of cookies) consent is saved in our ct-
ultimate-gdpr-cookie.
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Advanced cookie groups popup header content

PRIVACY SETTINGS

Decide which cookies you want to allow. You can change these settings at any time. However, this can result in some functions

no longer being available. For information on deleting the cookies, please consult your browser's help function. Learn maore

about the cookies we use.

WITH THE SLIDER, YOU CAN ENABLE OR DISABLE DIFFERENT TYPES OF

THIS WEBSITE WILL

Essential: Rememiber your cookie permission setting
Essential: Allow session cookies

Essential: Gather information you input into a contact
forms newsletter and ather forms across all pages
Essential: Keep track of what you input in shopping
cart

Essential: Authenticate that you are logged into your
User account

Essential: Remember language version you selected
Functionality: Remember social media settings

Functionality: Remember selected region and country

COOKIES:
4 —>
Labels @ ( @ > &
Block all Essentials Functionalicy Analytics Advertising

THIS WEBSITE WON'T
Analytics: Keep track of your visited pages and

interaction taken

Analytics: Keep track about your location and region
based on your IP number

Analytics: Keep track on the time spent on each page
Analytics: Increase the data quality of the statistics
functions

Advertising: Tailor information and advertising to your
interests based on e.g. the contant you have visited
before. (Currently we do not use targeting or targeting
cookies)

Advertising: Gather personally identifiable information

such as name and location

List of features

SAVE & CLOSE

The Cookie Privacy Panel allows user to select one of 4 cookies groups to be activated while he is browsing the
website. Advance cookie settings will be displayed when user clicks the “Change Settings” button in cookie consent

box.

Cookies

Accept

To make this site work properly, we sometimes place small datz files called cookies on your device. Most big websites do this too.

Change Settings

Read more
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Note: The Cookie Privacy Setting / Trigger will show when Use advanced cookie groups popup is activated in
Ultimate GDPR & CCPA > Cookie Consent > Advance settings tab.

Use advanced cookie groups popup

Currently available cookies level are:

 Essential - for cookies which are strictly necessary for your website to be able to operate or to provide user with

a requested service

* Functional - these are cookies that are designed for purposes such as enhancing a website’s functionality. These
are either not strictly essential for the website or functionality which user has requested to work, or are cookies
which serve non-essential purposes in addition to their essential purpose.

» Analytics - Analytical (or performance) cookies track and gather data about what a user does on a website.

* Advertising - Targeting (or advertising) cookies record information about your visit to and use of our website,

for advertising purposes.

You can add/change the text in the cookie group in Ultimate GDPR & CCPA > Cookie Consent > Advance settings.

Cookie popup Preferences Advanced settings

Advanced Cookies Settings

Show advanced cookie popup always,
event when the consent s given

Advanced cookie groups pepup header content

Use advanced cockie groups popup

o5 A e
41 Add Media Visual = Text

b || 7 || link || b-quote || det ns img || ul || ol code || more || close tags

<h2>Privatsphire-Einstellungen</h2>

<div class="ct-ultimate-gdpr-cookie-modal-
<p>Entscheiden 5ie, welche Cookies Sie zulassen méchten.

</p>

Einstellungen jederzeit &ndern. Dies
Verfigung
en der Cookies finden Sie in der Hilfe Ihres

«p>Sie kdnnen d

kann jedoch dazu fihren, d ige Funktionen nicht mehr

stehen. Informationen zum

Browsers.</p>
<span>ERFAHREN SIE MEHR UBER DIE VON UNS VERWENDETEN
COOKIES.</span>
</d

Cookies aktivi

Trigger cookie
Trigger cookie settings by lcon and Text v

Trigger cookie settings icon @

Lists of features

List of features available for Essential level (semicolon separated)

List of features not available for Essential level (semicolon separated)
List of features available for Functionality level (semicolon separated)

List of features not available for Functionality level (semicolon separated)
List of features available for Analytics level (semicolon separated)

List of features not available for Analytics level (semicclon separated)
List of features available for Advertising level (semicalon separated)

List of features not available for Advertising level (semicolon separated)

Labels
This website willlabel

Diese Website wird

This website won'tlabel Diese Website wird nicht

Block afflabel alles blockieren
Essentials label Wesentliches
Functionality label Funktionalitat
Analytics label Analytik
Advertising label Werbung

Additional settings

Here you can customize the cookie group popup.

2.4. Cookies Management
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» To change the text in the header of the cookie group popup, you add/change it in Advanced cookie groups
popup header content.

¢ Customize the font color of the cookie groups by changing the Cookie modal header color and Cookie modal
text color.

Modal styles

Cookie modal header color

- Select Color
- Select Color

Cookie modal text color

%, v 3% P

Block all

Essential Functionality Analytics Advertising

.

THIS WEBSITE WILL:

Essentizl: Remember your cookie permission setting

THIS WEBSITE WON'T:

Remember your login details

Essential: Allow session cookies Functionality: Remember social media settings

Essential: Gather infermation you input into a contact
forms, newsletter and other forms across all pages
Essential: Keep track of what you input in shopping
cart

Essential: Authenticate that you are logged into your
user account

Essential: Remember language version you selected

Functionality: Remember selected region and country
Analytics: Keep track of your visited pages and
interaction taken

Analytics: Keep track about your location and region
based on your IP number

Anazlytics: Keep track on the time spent on each page
Anazlytics: Increase the data quality of the statistics
functions

Advertising: Tailor information and advertising to your
interests based on e.g. the content you have visited
before. (Currently we do not use targeting or targeting
cookies.

Advertising: Gather personally identifiable information

such as name and location

 To add/change the list under the cookie levels:

— List of features available for Essential level (semicolon separated) - List here are the list that will show

in the left side under This Website Will when Essential level is activated.

— List of features not available for Essential level (semicolon separated) - List here are the list that will

show in the right side under This Website Won’t when Essential level is activated.

— List of features available for Functionality level (semicolon separated) - List here are the list that will

show in the left side under This Website Will when Functionality level is activated.
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— List of features not available for Functionality level (semicolon separated) - List here are the list that
will show in the right side under This Website Won’t when Functionality level is activated.

— List of features available for Analytics level (semicolon separated) - List here are the list that will show
in the left side under This Website Will when Analytics level is activated.

— List of features not available for Analytics level (semicolon separated) - List here are the list that will
show in the right side under This Website Won’t when Analytics level is activated.

— List of features available for Advertising level (semicolon separated) - List here are the list that will
show in the left side under This Website Will when Advertising level is activated.

— List of features not available for Advertising level (semicolon separated) - List here are the list that
will show in the right side under This Website Won’t when Advertising level is activated.

2.4.3 What Cookies are used on your website

Note: Functionality available since version 1.4

You can show a table with all cookies collected by your website with simple shortcode: [render_cookies_list]

Active cookies will be displayed in a table, like the following:

Cookie names Type of cookie  Firstor Third party Session or Persistent  Expiry Time Purpose
__cfduid Advertising persistent 23 May 2019 12:06:07

rtisin, sion
awkUUID Advertising persistent 19 Nov 2018 12:06:07

NID Advertising persistent 22 Nov 2012 12:06:09

__utma, _utmb, _utme, _utmt, _utmz, _ga, _gat, _gid Analytics third_party

act, wd, xs, datr, sb, presenc reg ext_ref, reg_fb_gate, reg_fo_ref  Advertising third_party

km _ai, km_tv, km_vs, __atuvs, __atuvc, uvc Functionality third_party

Note: Your website should be publicly accessible to correctly detect all cookies that are used on it

2.4.4 Whitelist Cookies

When a scenario that the set default privacy group is ‘Block All’ and the user will select ‘Block All’ cookie, the user
will see the cookie popup over and over since the user blocked saving cookies and there is no way for the system to
know that the user already accepted the cookie consent.

Whitelist cookies are cookies that are allowed even if you choose to Block all cookies in the site.

You can add whitelisted cookies in Ultimate GDPR & CCPA > Cookie Consent > Preferences:
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Cookie popup Preferences

Cookie check

Choose how often cookie check should
be performed

Choose default level of new cookies

Advanced settings

Weekly v

Essential A

Cockies whitelist (never block these
cockies, comma separated)

PHPSESSID, wordpress, wp-settings-,
_ cfduid, ct-ultimate-gdpr-cookie

&

Block selected/all cookies until user
consents

Set consent expire time [3]

31538000

This way you can allow selected cookies to be accepted even if cookie setting is set to ‘Block All’.

2.4.5 Display Advance Cookie Setting with link

Option to open cookie modal using a link, which you can display/add in any page on the site.

To do this, you can use shortcode: [ultimate_gdpr_cookie_popup] & [/ultimate_gdpr_cookie_popup]

You can add these shortcodes in the page that you would like to add the link.

Sample format:

[ultimate_gdpr_cookie_popup] COOKIE CONSENT LINK [/ultimate_gdpr_cookie_popup]
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+ <
2= + - 2 0 X :
+7x t
Lorem ipsum dolor sit amet, consectetur adipisicing elit. Proin nibh augue, suscipit a, scelerisque sed, lacinia in, mi. Cras vel lorem. Etiam pellentesque aliquet tellus. Phasellus pharetra nulla ac
diam, Quisque semper justo at risus. Donac venenatis, turpis vel hendrerit interd B e 20 X posuere libera dui id orci. Nam congue, pede vitae dapibus aliquet, elit magna !
vulputate arcu, vel tempus metus leo non est. Etiam sit amet lactus quis est cong s eget neque. Phasellus ornare, ante vitas consectetuer consequat, purus sapien
ultricies dolor, et mollis pede metus eget nisi. Praesent sodales velit quis augue. Cras suscipit, uma at aliquam rhoncus, uma quam viverra nisi, in interdum massa nibh nec erat,
+
2= + - 2 0 X
+7x
[ultimate_gdpr_cookie_popup] CCOKIE CONSENT LINK [fultimate_gdpr_cookie_popup]
+
i = - ¢ 0 X
+2x
GENERAL TERMS
+
2= + - ¢4 0 X
+7X

Lorem ipsum dolor sit amet, consectetur adipisicing elit. Proin nibh augue, suscipit a, scelerisque sed, lacinia in, mi. Cras vel lorem. Etiam pellentesque aliquet tellus. Phasellus pharetra nulla ac
diam. Quisque semper justo at risus. Donac venenatis, turpis vel hendrerit interdum, dui ligula ultricies purus, sed posuere libero dui id orci.

Nam congue, pede vitae dapibus aliguet, elit magna vulputate arcu, vel tempus metus leo non est. Etiam sit amet lectus quis est congue mollis. Phasellus congue lacus eget neque. Phasellus
ornare, ante vitae consectetuer consequat, purus sapien ultricies dolor, et mollis pede metus eget nisi. Prassent sodales velit quis augue. Cras suscipit, urna at aliquam rhoncus, uma guam
viverra nisi, in interdum massa nibh nec erat.

Front end:

INTRODUCTION

Lorem ipsum dolor sit amet, consectetur adipisicing elit. Proin nibh augue, suscipit a, scelerisque sed, lacinia in, mi. Cras vel lorem.
Etiam pellentesque aliquet tellus. Phasellus pharetra nulla ac diam. Quisgue semper justo at risus. Donec venenatis, turpis vel
hendrerit interdum, dui ligula ultricies purus, sed posuere libero dui id orci. Nam congue, pede vitae dapibus aliquet, elit magna
vulputate arcu, vel tempus metus leo non est. Etiam sit amet lectus quis est congue mellis. Phasellus congue lacus eget neque.
Phasellus ornare, ante vitae consectetuer consequat, purus sapien ultricies dolor, et mollis pede metus eget nisi. Praesent sodales
velit quis augue. Cras suscipit, urna at aliguam rhoncus, urna guam viverra nisi, in interdum massa nibh nec erat.

COOKIE CONSENT LINK

GENERAL TERMS

Lorem ipsum delor sit amet, consectetur adipisicing lit. Proin nibh augue, suscipit 3, scelerisgue sed, lacinia in, mi. Cras vel
lorern. Etiam pellentesque aliquet tellus. Phasellus pharstra nulla ac diam. Quisque semper justo at risus. Donec venenatis,
turpis vel hendrerit interdumn, dui ligula ultricies purus, sed posuere libero dul id orcl.

MNam congue, pede vitae dapibus aliquet, elit magna wulputate arcu, vel tempus metus leo non est. Etiam sit amet lectus quis est
congue mollis. Phasellus congue lacus eget neque. Phasellus ornare, ante vitae consectetuer consequat, purus sapien ultricies dolor,

AU N U e m e it

P U

2.5 Cookie Groups

Note: The Cookie Privacy Setting / Trigger will show when Use advanced cookie groups popup is activated in
Ultimate GDPR & CCPA> Cookie Consent > Advance settings tab.

Use advanced cockie groups popup Enenles] Disable
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The Cookie Groups for Ultimate GDPR & CCPA are cookie levels, where you would need to pass level 1 to get to
level 2. These levels have cookies that are set in them and when you pass to another level, these cookies will also
remain.

This will allow tracking of only the necessary cookies or possible cookies.

» Essential - For cookies which are strictly necessary for your website to be able to operate or to provide user
with a requested service

e Functional - These are cookies that are designed for purposes such as enhancing a website’s functionality.
These are either not strictly essential for the website or functionality which user has requested to work, or are
cookies which serve non-essential purposes in addition to their essential purpose.

* Analytics - Analytical (or performance) cookies track and gather data about what a user does on a website.

* Advertising - Targeting (or advertising) cookies record information about users visit to and use of your website,
for advertising purposes.

You can customize the cookie groups as you see fit. You can disable, rename, add/remove cookies, etc., the cookie
group of your choice.

When a user opens the site for the FIRST time, the cookie group would depend on what the admin have set. These are
the ways to set the default cookie group:

1. Block Cookies Until User Gives Consent
You can set this option in Ultimate GDPR & CCPA > Cookie Consent > Preference tab.

Cookie popup Preferences Advanced settings

Cookie check

Choose how often cookie check should Never v
be performed

Choose default level of new cookies Essential v

Cookies whitelist (never block these
cookies, comma separated)

PHPSESSID, wordpress, wp-settings-,
__cfduid, ct-ultimate-gdpr-cookie

P

Block selected/all cookies until user
consents

Set consent expire time [s]

31536000
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This will block all the cookies that are not in the cookies whitelist.

Sample:

& C @ Secure | https;//www.createit.pl/gdpr/

Get to know the Ultimate GDPR with
video tutorial

“| % (] Eemenis Console Sources Network  Application > a1l i x

Application c e Filter
Name Value o[ B[S [ [Ser[Sen

Ultimate GDPR for WordPress Video Tuiorial

Cookies
To make this site work properly. we sometimes place small data files called cookies on your device. Most big
websites do this too.

2. Set a Default Cookies Group
You can set this option in Ultimate GDPR & CCPA > Cookie Consent > Additional settings tab.

Additional settings

Hide "Block All" level features T Disabled

Hide "Essential" level features T Disabled
Hide "Functionality” level features Enable Disabled
Hide "Analytics" level features

Enable Disabled

Hide "Advertising" level features Enable Disabled

Advanced cookie popup 'save & close' save & Close
button label (leave empty for default)

Select default privacy group Advertising v

Reload page when user saves changes Enable Disabled

- I

Select privacy group after user accepts

- F Advertising
cookies in the popup
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This will block the cookie group set by the admin.

Sample: Default Cookie Group is Advertising

(\TEGDPR  FEATURES LIVE ADMIN DEMO COMPATIBILITY & FAQ DOCUMENTATION & SUPPORT A C ©® X fiter

LEGAL BASE AUTHOR BUY - oIS

ULTIMATE GDPR . ctulimate.. | ey
PLUGIN

to know the Ultimate GDPR with our
video tutorial

whimate:GDPRfonWordPress:Video Tutorial

Cookies
To make this site work properly, we sometimes place small data files called cookies on your device. Most big
websites do this too.

.

Note: When a user has already used your site, the cookie group that the user has set before will be remembered unless
the cache has been cleared on the users side.

This is used to limit the cookies that are in the site to gather details about the user.
Read these parts of the documentation for:
» Cookie Group Panel - Customize cookie group’s look.

e Services Manager - Add/remove cookies in a group.

2.6 Use Services Manager

This is where the cookies that are detected are saved. You can change the cookies’s details here. You can also make a
customized cookie to be blocked/accepted in your site.

To detect cookies that are used in your site, click the Scan for cookies button at the bottom of Ultimate GDPR &
CCPA > Cookie Consent > Cookie consent settings.

Note: To have the Block All cookies functionality working, you must first detect all cookies and save them in the
Services Manager.

The cookies that are detected is then shown in the Ultimate GDPR & CCPA > Cookie Consent > Services Manager.
In Ultimate GDPR & CCPA > Cookie Consent > Services Manager you will see:
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Enter title here

1D

Service name

Script names

Please input comma separated names of cookie creating scripts

Cookie names

Please input comma separated cookie names

Type of cookie

Essential

First or Third party?

Can be blocked?

Session or Persistent?

Expiry Time

Purpose

Do you want to activate this service?

* Title - Used only for admin user to navigate through services.

e ID - Identifier for the cookie script.

2.6. Use Services Manager
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* Service name - Name of the service which will be displayed in table created using [ren-
der_cookies_list] short code.

* Script names - Comma separated names of java-script scripts which are to be blocked, to prevent
creation of unwanted cookies.

Note: Plugin searches html content of <script>, <noscript> and <iframe> tags. If plugin
finds any of “script names” it removes entire content of given tag.

* Cookie names - Comma separated names of cookies which are to be blocked. It’s important use
actual name of cookie, not name of service. For example — to block google analytics user must input
“_ga” instead of “Google Analytics”.

¢ Type of cookie - Drop-down allowing user to pick which category should the cookie be in. This
allows user to agree for chosen cookie group.

¢ First or Third party ? - First party cookies are cookies created by website itself, the rest are 3rd
party.
¢ Can be blocked ? - When user creates new service, you should test if blocking works as intended.

By default all cookies we do not recognise that is detected by Scan for cookie option have
this field set to false.

This field is used only to display information in table created using [render_cookies_list]
shortcode.

* Session or Persistent ? - If cookie is deleted when session ends, or if it has set expiry date.

This field is used only to display information in table created using [render_cookies_list]
shortcode.

« Expiry Time - Fill only if cookie is Persistent. Input how long cookie is stored and use seconds.

* Purpose - Purpose of the cookie. This field is used only to display information in table created using
[render_cookies_list] shortcode.

* Do you want to activate this service? - Option to activate or deactivate.

Note: Only services which are active, are being blocked. Unchecking this checkbox
makes the plugin ignore this service.

2.6.1 How to add Third Party Cookies

When a third party cookie is not detected by the cookie scanner, you can add the third party cookies manually.

To add third party cookies, you can add the Cookie name of the cookies that you would like to block in Ultimate
GDPR & CCPA > Services Manager under Cookie Names.

Sample third party setup:
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Tawk

(1]
15327167662
Service name

fawk.to

Script names
Please input comma separated names of cookie creating scripts

fawk.to

Cookie names
Please input comma separated cookie names

Tawk_5a7a0298d7591465c7076ef7, TawkConnectionTime

Type of cookie

Functionality v
First or Third party?

Third party ¥
Can be blocked?

Session or Persistent?

Persistent T

Expiry Time

1542716231

Furpose

Do you want to activate this service?

v
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2.6.2 Tracking Users Anonymously (Google Analytics)

To use this feature correctly, these are some pointers:

¢ In the Ultimate GDPR & CCPA > Services Manager, uncheck the Do you want to activate this service? so

that Google Analytics won’t be blocked.

Can be blocked?

Session or Persistent?

Expiry Time

Purpose

Do you want to activate this service?

* The Google Analytics Tracking ID should be added in Ultimate GDPR & CCPA > Cookie popup for the
feature to work since Google Analytics will be blocked as long as the consent isn’t given.

Google Analytics Tracking ID

Home Page
GDPR
FAQ

Google Analytics Tracking 1D (disable
tracking for this ID when cookies
consent not given), eg. UA-118586768-1

Enable Google Analytics anonymized IP
tracking (read more) @

* Enable the option for anonymization in Ultimate GDPR & CCPA > Cookie popup. This option will allow
you to track anonymously without collecting any user data in compliance with GDPR & CCPA.
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T GDPR
FAQ <

Google Analytics Tracking ID

Google Analytics Tracking ID (disable
tracking for this 1D when cookies consent
not given), eg. UA-118586768-1

Enable Google Analytics anonymized IP
tracking (read more) @

What does Tracking Users Anonymously exactly mean?

After following the instruction above, IP of all users visiting the website will be altered before sending the tracking
data to Google. This will make impossible for search engines to directly assign tracking data to an exact IP Address
making this action GDPR & CCPA compliance even if the user didn’t accept cookie consent.

For more advanced information for this functionality access this link.

2.6.3 If you want to block a specific cookie

To find a script to block, view page source, search for ‘<script>’, ‘<noscript>" and ‘<iframe>’ tags. Then, to block a
tag, copy any of its content fragment, eg.

In the Service Name field, you should add the script that needs to be block in the site. For example:

for script:

<script type='text/javascript' src='http://ctll.pinky.createit/
—boilerplate/wp-includes/js/jquery/jquery.js?ver=1.12.4"'></script>

* you can copy: ‘jquery.js’

for tag:

<noscript>var x=start_tracking();</noscript>

* you can copy: ‘start_tracking()’

for iframe:

<iframe width="200" height="113" src="https://www.youtube.com/embed/
—xxxxx?feature=oembed" frameborder="0" allow="autoplay; encrypted-
—media" allowfullscreen></iframe>

* you can copy: ‘youtube.com’ or ‘encrypted-media’ or any other part of the tag content

Note: It’s best to copy as large and unique tags content as possible, to avoid blocking other, non related tags by
accident. By default, if particular services cookies are detected, these scripts contents are set to be blocked
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Addthis:
addthis_widget

Google Analytics
google—-analytics.com/analytics. js

Facebook Pixel:
"pixel-cat.",
"fbg('init'",
"www.facebook.com/tr?id",
"/pixelyoursite/"

2.6.4 How to check for cookies
Mozilla Firefox

In Firefox, press F12 and navigate to Storage tab. There a list of cookies with all necessary information should be
displayed.

E4 example@example.com Q & Login

B Estato 08001234567 @ QO N DE

Our Agent Are At Your

g - |

A7 phinky.createit/bg/sample-bulgarian-front-page/

@ L Inspector Console [ Debugger  {} StyleEditor (& Pedformance ik Memory = Network & Storage HE IS0 E x
£ Cache Storage + @ Filter items
£ Cookies Name Domain Path Expires on Last accessed on Value HetpOnly sameSite
t-ultimate-gd...  ct7.phinky.crea... / Sat, 08 Jun 2019 140412 ... Fri, 08 Jun 2018 140418 .. | eyljb25zZWSOX2RIV2xpbmVkljpm¥WsaZS... | false Unset
§ Indexed DB HPSESSID et7.phinky.crea... [ Session Fri, 02 Jun 2018 14:04:09 .. | 230gdttrgmtuvvbnbjlrpinolc false Unset
£ Local Storage ILlanguage  cf7.phinky.crea... / Fri, 08 Jun 2018 22:50:29 ... | Fri, 08Jun 2018 140453 .. bg false Unset

£ Session Storage

Google Chrome

In Google Chrome, press F12 and navigate to Application tab. Click on the drop down arrow beside Cookies below
Storage. The list of cookies with all necessary information should be displayed.
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Listing ID

ﬁ Estato

Partner

Q SEARCH FOR PROPERTY

Category

— -

[ ﬂ Elements Conscle Scources  MNetwork Performance  Memory  Application  Security  Audits a7
e A=~ Y=
» 82 Local Storage MName Value Domain | Path Expires... | Size HTTP Secure | Samdb...
Session Storace 1F_JAR 2018-06-07-14 gstatic.. |/ 2018-0.., 19
ndexedDE h NID 131=Z aHHIUBC-fp77CTIrAZnCexlXKmih... | .gstatic... |/ 2018-1.., 135 o
S Websal PHPSESSID Av0dvp3bekdj2rovheBigulbd ct?.phi... |/ 1969-1... 35
v @ Cookies _drip_client_§934213 vid%25304c0ebff04af30136a6100e8acdd 7defe... | ct.phi. |/ 2020-0... 209
@ nitpujctT phinkycreatei || —cLcumrent admin langusge ... |en ctT.phi.. |/ 2018-0.., 62
_icl_current_language en ct7.phi.. |/ 2018-0.., 23
ache ct-ultimate-gdpr-cookie eyljpd 32ZZWS0X2RIY 2epbmVkljpmYWizZSwiv2... | ctT.phi... |/ 2019-0... 167
P lanauage |7] TP 17 TOT5-0... 4E}

Plugin

Cookies can also be detected using plugin’s built in mechanism called “Scan for cookies”. Cookie detection can be
done using one button in wp-admin.

Navigate to Ultimate GDPR & CCPA > Cookie Consent. On the bottom of the page click on DScan for cookies

button.

Please be patient, since this process might take a while. If no cookies were found please wait for around one hour and
try again. In case this does not help please contact our support.

Press 'Save changes' before downloading logs if you changed any options

Save Changes

Download consents log

Detect cookies

Your website should be publicly accessible so that the Cookie Detector can work properly.

2.6. Use Services Manager
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2.7 Consent Log’s Storage

This feature will store the consents from the users of your site. Currently, we support logs for Cookie Consent, Privacy
Policy Consent, Terms and Conditions Consent and Services Consent Checkboxes.

You can download the consent logs using the following:
* Cookie Consent

Ultimate GDPR & CCPA > Cookie Consent

OO o o o v Ty ]

Ultimate GDPR empty for default)
Cookie popup 'read more' button label Read more

Ultimate GDPR
L= (leave empty for default)

Cookie Consent

Cookie popup 'change settings' button Cookies Settings
label (leave empty for default)

Press 'Save changes' before downloading logs if you changed any options

Save Changes

Data Breach

Data Rectifi
Downlead consents log

Detect cockies

Your website should be publicly accessible so that the Cookie Detector can werk praperly.

¢ Privacy Policy Consent
Ultimate GDPR & CCPA > Privacy Policy

e e
Ultimate GDPR -

Ultimate GDPR

Cookie Consent

Convert the following text to Privacy Policy link in all services Privacy Policy
templates, eg. 'Privacy Policy'

Terms And Conditions

Privacy Policy
Right To Be Fo L ; -

2 Do not block user agents (eg. bots) containing the following texts bot, crawl, slurp, spider, med
Diata Access (comma separated)

Data Breach

Press "Save changes” before downloading logs if you changed any options

Save Changes

ad Google Analytics
Download consents log

£} Post SMTP

¢ Terms and Conditions Consent

Ultimate GDPR & CCPA > Terms and Conditions
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TETTTTE WETSTOTE, B0, T.UPTIT WO TTIanTgeE 10 USET 1195 T OgiveE COTTEE
Ultimate GDPR again)
Ulimate GDFR

Cookie Consent
Convert the following text to Terms and Conditions link in all

ervices Manager . . .
: : - services templates, eg. "Terms and Conditions

Terms And Conditions
Privacy Policy

Right To Be Forgotten Do not block user agents (eg. bots) containing the following t
Data Access (comma separated)
Data Breach
Data Rectification

ervices . B ) i
Press "Save changes” before downloading logs if you change
Pseudonymization

; Save Changes
Plugins

ad Google Analytics

Download consents log

£+ Post SMTP

¢ Services Consent Checkboxes

Ultimate GDPR & CCPA > Services
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/) Ultimate GDPR
Wordfence
Ultimate GDPR

Cookie Consent WP Comments

ervices Manager
= WordPress Posts

Terms And Conditions

Privacy ) WP User Data

Right To Be Forgotten

WP Job Manager
Data Access

Data Breach WP Simple Paypal Shopping Cart
Data Rectification

. Youtube

Services

Pseudonymization

Plugins Save Changes

ad Google Analytics

Download all consents log

£+ Post SMTP

2.7.1 Logged Users

Users of your website that are logged in with whom accepted any of the consent that are supported will be registered
in the log for that service.

Sample log for Terms and Conditions:

| ct-ultimate-gdpr-terms-logs - Notepad - O X
File Edit Format View Help

lid: 2type: ct-ultimate-gdpr-termsuser_id: lemail: jOEENND.-luscr_ip: user_agent: time:
1532433034data: {"terms_expire_time":1563969834,"terms_consent_time":1532433034,"terms_version”:"1.0"}

The user id, email address, and time of consent, of the user will show in the log.

2.7.2 Non-logged In Users

Users that are not logged in that accepted any of the consent that are supported will be registered in the log for that
service.

There are two ways that the consent is registered:
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Note: You can enable both options.

Services options

Recaptcha key (for myaccount shortcode
submissions)

Recaptcha secret key (for myaccount
shortcode submissions)

When logging consents of users who did Disabled

not accept Privacy Policy, log their IP _

When logging consents of users who did Disabled
not accept Privacy Policy, log their User
Agent

1. Logged by User IP

This feature will work when “When logging consents of users who did not accept Privacy Policy, log
their IP” is activated.

The IP of the user will be shown with the user id and time of consent.

» Sample log for Terms and Conditions:

) ct-ultimate-gdpr-cookie-logs (2) - Notepad - m} X

File Edit Format View Help

id: ltype: ct-ultimate-gdpr-cookieuser_id: ser ip: 192.168,200.84hser_agent: Mozilla/5.8
(Windows NT 1@.8; Win64; x64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/67.8.3396.99
Safari/537.36time: 1531284289%data:

{"consent_declined":false, "consent_expire_time":1559726128, "consent_level”:3,"consent_time
711531284289}

2. Logged by User Agent

This feature will work when “When logging consents of users who did not accept Privacy Policy, log
their User Agent” is activated.

The browser and computer details of the user will be shown with the user id and time of consent.

e Sample log for Terms and Conditions:

) ct-ultimate-gdpr-cookie-logs (2) - Motepad - [m} >

File Edit Format View Help

fid: 1type: ct-ultimate-gdpr-cookieuser_id: Buser_ip: 192.168.200.84Lser_agent: Mozilla/5.0
Tindows N1 10.8; Winbd; xbd) AppleWebKit/537.36 (KATML, 1ike Gecko) Chr'omeja?.a.ﬂ'%._gr'
| i ime: 1531284289data:

{"consent_declined":false, "consent_expire_time":1559726128, "consent_level™:3,"consent_time
":1531284289}

2.8 Content Protection

This feature is used by using this shortcode: [ultimate_gdpr_protection level=4] & [/ultimate_gdpr_protection]
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This feature will hide any content inside the shortcode unless the cookie group chosen by the user of the site will meet
the requirements of the shortcode.

This content requires cookies

OUR AGENTS
le-Bob Doser le—Kristine Black le-Mia Conzales lw_Robert S. Morris
Bob Doser Kristine Black Mia Gonzales Robert S. Morris

i

]

bobdonser@exampleco kristine black@examplec mizgonzales@examplec

m om am com

To add the shortcode in the page, follow this format:

[ultimate_gdpr_protection level=4| CONTENT[/ultimate_gdpr_protection]

Note: The level in [ultimate_gdpr_protection level=4] is the cookie group condition that needs to be meet for the blur
to clear.

Level | Cookie Group
1 Essentials

2 Functionality

3 Analytics

4 Advertising

A label/notice will be shown in front of the blurred area.
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This content requires cookies

OUR AGENTS
le.Bob Doser leKristine Blac lw.Mia Conzales lw.Robert 5. Morris
Bob Doser Kristine Black Mia Gonzales Robert S. Morris

R ala ] b ammeremen # ammereoan b o memae

You can customize the label/notice in Ultimate GDPR & CCPA > Cookie Consent > Preference tab, under Protec-
tion shortcode.

TorCT OGO TR

Box style Classic v
Box shape Squared v
P Background color B seiect color
ser Text color Select Color
31536000
Protection shortcode
Protection shortcode label This content requires cookies
Rounded v
Custom style CSS
Normal v
Custom style CSS
Select Color
- Select Color
Select Color

Sample when condition is meet
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Ultimate GDPR for WordPress Video Tutorial Q »

Privacy settings

OUR AGENTS
le-Bob Doser leaKristine Black lwaMia Gonzales lw2Robert S. Morris

Bob Doser Kristine Black Mia Gonzales Robert S. Morris

2.9 Customize

2.9.1 Cookie Consent

Cookie consent can be customized in Ultimate GDPR & CCPA > Cookie Consent > Preference Tab under the
Cookie notice box.
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Cookie notice box
Box style Modern v
Box shape Rounded v

Background color - Select Color

Background image

Choose file | Mo file chosen

Text color - Select Color

You can choose the box style of the cookie consent on what style you want.

¢ Classic

Cookies To make this site work properly, we sometimes place small data files called cookies on your device. Most big websites do this too.

¢ Classic Blue

ymetimes plac data files ca device. Most big websites do this too.

Read more 9

e Modern

Listing ID Category Property Type Listing Type

Cookies To make this site work properly, we sometimes place small data files called cookies on your device. Most big websites do this too.

| Accept | | Cookies Settings | ‘ Read more

Note: Background color is only applicable to Classic or Modern Box Styles.
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You can also use an image as the background for the cookie notice.

e

T TRLT
- .- Ty 5
Cookies To make this site work properly, we S8metimes place small data fjl&s called cookies on'yo ig websites do this too.
N & .

[

==

You can choose the text color of the text in the cookie consent.

2.9.2 Terms and Conditions and Privacy Policy
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Buttons

Privacy Palicy

Instructions

1. Place [ultimate_gdpr_policy_accept] shortcode on your existing Privacy Policy page to add an accept button.
2. Select Privacy Policy page below, so users can be redirected there to give their consent.

Require administrators to accept Privacy Policy (redirect) Tl Disabled

T

Require logged in users to accept Privacy Policy (redirect) TrrislE Disabled
Require not logged in users/guests to accept Privacy Policy (redirect) Trevie (il
WordPress Privacy Policy page Click here to create

Page with existing Privacy Policy ‘ |

Privacy Policy Custom URL ‘

Open Privacy Policy in a new Tab Enabled Bl

Page to redirect to after Privacy Policy accepted ‘ Last visited page

Shortcode Button Styling Theme Default

Set consent expire time [s] Cookie box buttons
Privacy Policy version, eg. 1.0 (if you change i, user has to give consent ' 1.0

again) .

To customize the buttons for Terms and Conditions and Privacy Policy, you have 2 options: Theme Default or Cookie
box buttons

¢ Theme Default

This is the default button design that your WP theme is using. It will give you a uniform look to your
site.
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¢ Cookie box buttons

This option is using the same button design as the Cookie consent. Which you can change in Ultimate
GDPR & CCPA > Cookie Consent > Preference Tab.

Buttons styles

Button shape Rounded ¥
Button size Mormal r
Button text color Select Color

Button background color - Select Color

Button border color Select Color

Note: When you change the look in the Preference Tab, it will not just change the buttons for Terms
and Conditions and Privacy Policy. It will affect the look of the buttons for Cookie consent.

Bot Detection

Detect whether a bot (Google bot) or a human enters the site and enforce the Terms and Conditions and Privacy Policy.
You can add the bot name in:

e Terms and Conditions - Ultimate GDPR & CCPA > Terms and Conditions > Do not block user agents (eg.
bots) containing the following texts (comma separated)

* Privacy Policy - Ultimate GDPR & CCPA > Privacy Policy > Do not block user agents (eg. bots) containing
the following texts (comma separated)

Note: You can see the bot database here

2.9.3 Right to be Forgotten

Note: This feature will show the plugins that are integrated in Ultimate GDPR that gather data from the users.
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Changing the Text in Forgotten Form

FORGET ME

Below, you can browse services which collects your personal data on this website. Check services
you wish to be forgotten by. This will send a request to the website admin. You will be notified by
e-mail once this is done."

WooCommerce
WooCommerce gathers data entered by users in shop orders

WP Comments
WordPress Comments are data entered by users in comments

WordPress Posts
WordPress posts author data

WP User Data
WordPress user data stored as user meta data in database

m
o

LD Nave y EMa

SUBMIT

You can change the Name and Description that will be shown in the Forget Me tab of the GDPR shortcode.

0
(=]
T
]
m
=]
T
=]
]
i)
h
1
m
m

To customize the text in the form for Right to be Forgotten, go to Ultimate GDPR & CCPA > Services.

Look for the service that you would like to change.

Note: For this example, we’ll use WooCommerce.
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WooCommerce -

[WooCommerce] Name

WooCommerce Sample y
4

[WooCommerce] Description

Sample Description

[WooCommerce] Inject consent
checkbox to order fields

[WooCommerce] Inject consent
checkbox to account forms

[WooCommerce] Inject consent
checkbox to checkout

Enable Disabled

Enable Disabled

Enable Disabled

Add the Changes that you want, then click on the Save Changes button.

It should reflect in the form:
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FORGET ME DATA RECTIFICATION

Below, you can browse services which collects your personal data on this website. Check services
you wish to be forgotten by. This will send a request to the website admin. You will be notified by
e-mail once this is done."

Name
WooCommerce Sample
Sample Description Descri ption

WP Comments
WordPress Comments are data entered by users in comments

WordPress Posts
WordPress posts author data

WP User Data
WordPress user data stored as user meta data in database

o
D
u
4l
=

T
]
i
]
¢

o
[nl
LA
il
m

=)
i

T
=]
5
=]
i

0
[iF]
o
o
[T

SUBMIT

Modify Right to be Forgotten Form

There are 2 ways to remove an option in the Right to be Forgotten form.
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FORGET ME

Below, you can browse services which collects your personal data on this website. Check services
you wish to be forgotten by. This will send a request to the website admin. You will be notified by
e-mail once this is done."

WooCommerce
WooCommerce gathers data entered by users in shop orders

WP Comments
WordPress Comments are data entered by users in comments

WordPress Posts
WordPress posts author data

WP User Data
WordPress user data stored as user meta data in database

_,
m
0

3
]
[
iT
]
(]
=]
it
=
T
]
in
0
T
(=]
5]
=]
i)
[i%]
[}

SUBMIT

Note: This example will remove the WP Comment from the Right to be Forgotten form.

1. Adding a filter in the functions.php of the theme that is used
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| Search estato-theme
" Marne - Date modified Type Size

s 9 content-auaio 28/UDf4U16 3EI M FHF Hie 2 KB

P j content-featured-post 24y 4 PHP File 2KB

s j content-gallery 24y 018 3:4 PHP File 2KB

s # g content-image 24y 4 PHP File 2KB

_| content-link 24y 4 PHP File 1KB

’ j content-none 24y 4 PHP File 1KB

j content-page PHP File 1KB

j content-quote PHP File 2KB

"] content-video PHP File 2KB

j custom-archive-ct-portfolio PHP File 3KB

j featured-content 24, 4 PHP File 1KB

] footer PHP File 7KB

| | functions PHP File 84 KB |

| header 24y 4 PHP File 16 KB

“Jimage 24 i PHP File 3KB

“index 24 4 PHP File KB

s ) page 24 4 PHP File 2kB

5 "] page-abuse PHP File 3KB

j page-calculate PHP File 3KB

j page-contact-us PHP File 2KB

j page-maintenance PHP File 3KB

) g page-privacy-policy PHP File 2KB

ne (E) % page-property-page-grid PHP File 5KB

_| page-property-page-listing PHP File 5KB

135 v j page-terms-conditions PHP File 2KB
1 selected 64.0 KB

[EH=

Add this filter in the file:

add_filter( 'ct_ultimate_gdpr_model_services_default', 'my_services' );
function my_services( Sservices ) {
foreach( $services as Skey => Sval ) {
if ( Sval == 'CT_Ultimate_GDPR_Service_WP_Comments' ) {
unset ( $services|[ Skey ] );
}
}
return S$Sservices;
}
2. Overwrite the Shortcode’s template
Create a Php file in your theme with a file name: shortcode-myaccount.php
wp-contentitheme: ato-theme\ct-ultimate-gdprishortcode) V| [¥] Search shortcode pel
ol Name ~  Date modified Type Size

” . | " shortcode-myaccount 28/05/2018 4:32 PM_ PHP File 1ke]

s #

ts o

-

Then add this code in the file:

<?php

/*+ @var CT_Ultimate GDPR_Service Abstract Sservice */
foreach ( Soptions|['services'] as S$service ):

if ( $service->get_id() == 'wp_comments' )

2.9. Customize
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continue;
endif;

?>

<div class="ct-ultimate-gdpr-service-options">
<div class="ct-ultimate-gdpr-service-option">

<?php endforeach; ?>

<input type="checkbox" name="ct-ultimate-gdpr-service-forget[]"

value="<?php echo esc_attr( Sservice->get_id() ); 2?>">

</div>

<div class="ct-ultimate-gdpr-service-details">

<div class="ct-ultimate-gdpr-service-title"><?php echo esc_html ( Sservice-
—>get_name () ); ?></div>

<div class="ct-ultimate-gdpr-service-description"><?php echo esc_html (
—Sservice->get_description() ); ?></div>

</div>

</div>

2.10 Export/import Options

Starting from Ultimate GDPR & CCPA v1.6.3, you can export or import the current plugin settings or the services

from Service Manager of your Ultimate GDPR & CCPA Plugin.

This will give you an efficient and fast way to copy your current GDPR settings to another site that has Ultimate GDPR

& CCPA Plugin installed.

2.10.1 GDPR & CCPA Plugin Settings

Export

To export the GDPR & CCPA Plugin Settings, follow these steps:

¢ In your dashboard, go to Ultimate GDPR & CCPA > Ultimate GDPR & CCPA > Introduction

tab.

* Look for the Export/import options section of the page.

* Under Export/import options, you sill see the Export plugin settings button.

112

Chapter 2. How to



Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

Custom Fields

52 Demo

Export/import options

You can export current plugin settings to a file which can be used to import the settings on other websites

#  MailChimp for WP
Export plugin settings

AMP

Select file to import settings from. Your current settings will be overwritten.
& Performance

Ultimate GDPR Choose file |No file chosen

|

Import plugin settings

Ultimate GDPR

Cookie Consent Export services from Service Manager

Export services

Select file to add services from. Your current services will not be removed.

Choose file |No file chosen

Import services to Service Manager

|

* Click on the button and a .json file will be downloaded.

* This contains the settings from your Ultimate GDPR & CCPA Plugin. This can be used to import
the settings.

This PC » Documents
~
ct-ultimate-gdpr
-settings-export-
07-26-2018,jsen
Import

To import the GDPR & CCPA Plugin Settings from a .json file from another GDPR & CCPA Plugin, follow these
steps:

¢ In your dashboard, go to Ultimate GDPR & CCPA > Ultimate GDPR & CCPA > Introduction
tab.

* Look for the Export/import options section of the page.

e Under Export/import options, you will see the Choose file button below the Export plugin settings
button.
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Exportfimport options

‘You can export current plugin settings to a file which can be used to import the settings on other websites

Export plugin settings

Select file to import settings from. Your current settings will be ovenwritten.

Choose file | No file chosen

Import plugin settings

Export services from Service Manager

Select file to add services from. Your current services will not be removed.

Choose file | No file chosen

Import services to Service Manager

* Click on the button and you will be asked to choose the .json file for the GDPR & CCPA Plugin.

* Once you have chosen a file, below the Choose file button you will see the Import plugin settings

button.

* Click on the Import plugin settings button, this will import all the details in the .json file.

Export/import options

You can export current plugin settings to a file which can be used to import the settings on other websites

Export plugin settings

Select file to import settings from. Your current settings will be overwritten.

Choose file |ct-ultimate-g...-26-2018.json

Import plugin settings

Export services from Service Manager

Export services

Select file to add services from. Your current services will not be removed.

Choose file |No file chosen

Import services to Service Manager

2.10.2 Services from Service Manager

114 Chapter 2

. How to



Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

Export

To export the Services in the Service Manager of a Ultimate GDPR & CCPA Plugin, follow these steps:

* In your dashboard, go to Ultimate GDPR & CCPA > Ultimate GDPR & CCPA > Introduction
tab.

¢ Look for the Export/import options section of the page.

¢ Under Export/import options, you sill see the Export services button.

Exportlimport options

You can export current plugin settings to a file which can be used to import the settings on other websites

Export plugin settings

Select file to import settings from. Your current settings will be overwritten.

Choose file | No file chosen

Import plugin settings

Export services from Service Manager

Select file to add services from. Your current services will not be removed.

Choose file | No file chosen

Import services to Service Manager

* Click on the button and a .json file will be downloaded.

« This file contains a copy of the cookies that are saved/added and its settings in the Service Manager.
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”
ct-ultimate-gdpr ct-ultimate-gdpr
-settings-export- -services-export-
07-26-2018,json 07-26-2018,json

Import

To import the Services from a Service Manager of another GDPR & CCPA Plugin from a .json file, follow these steps:

¢ In your dashboard, go to Ultimate GDPR & CCPA > Ultimate GDPR & CCPA > Introduction
tab.

* Look for the Export/import options section of the page.

* Under Export/import options, you will see the Choose file button below the Export Services button.
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Export/import options

You can export current plugin settings to a file which can be used to import the settings on other websites

Export plugin settings

Select file to import settings from. Your current settings will be overwritten.

Choaose file | No file chosen
Import plugin settings

Export services from Service Manager

Select file to add services from. Your current services will not be removed.

Choose file |[No file chosen

Import services to Service Manager

* Click on the button and you will be asked to choose the .json file for the services.

* Once you have chosen a file, below the Choose file button you will see the Import services to
Service Manager button.

* Click on the Import services to Service Manager button, this will import all the details in the .json
file.

Export/import options

You can export current plugin settings to a file which can be used to import the settings on other websites

Export plugin settings

Select file to import settings from. Your current settings will be overwritten.

Choose file | No file chosen

Import plugin settings

Export services from Service Manager

Export services

Select file to add services from. Your current services will not be remaoved.

Choose file | ct-ultimate-g...-26-2018. json

[ Import services to Service Manager

* You will see the changes in Ultimate GDPR & CCPA > Services Manager.

2.10. Export/import Options
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CHAPTER 3

Integration for Additional Plugins

3.1 Integrate Ultimate GDPR & CCPA with Plugin

These are some of the hooks to declare for collecting data and compatibility.

Note: PLUGIN_NAME is the name of your plugin as in ‘active_plugins’ wordpress option.

ct_ultimate_gdpr_controller_plugins_compatible_ PLUGIN_NAME

This is used to declare whether or not the plugin is compatible with Ultimate GDPR & CCPA. The result will be

shown in Ultimate GDPR & CCPA > Plugins.

Plugin Collects user data
Contact Form 7 Yes

Ultimate GDPR Yes

Events Manager Yes

Yoast SEQ Probably

CT S5L Fixer Unknown

GA Google Analytics Unknown
WPEBakery Page Builder Unknown

W3 Total Cache Unknown

Compatible with Ultimate GDPR
Yes
Yes
Yes
MNo
No
Mo
MNo

MNo

Example: Woocommerce Ultimate Discount plugin:

ct-woocommerce-ultimate-discount/ctUlItimateDiscount.php

Declare Compatible
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add_filter( "ct_ultimate_gdpr_controller_plugins_compatible_ct-

—woocommerce-ultimate-discount/ctUltimateDiscount.php", '__ _return_
—true' );

Declare Not Compatible
add_filter( "ct_ultimate_gdpr_controller_plugins_compatible_ct-
—woocommerce-ultimate-discount/ctUltimateDiscount.php", '_ return_
—~false' );

Declare Partly Compatible

add_filter( "ct_ultimate_gdpr_controller_plugins_compatible_ct-
—woocommerce-ultimate-discount/ctUltimateDiscount.php", is_
—compatible );

function is_compatible () {

return CT_Ultimate_GDPR_Controller_Plugins::PLUGIN_COMPATIBLE_PARTLY;
}

ct_ultimate_gdpr_controller_plugins_collects_data_ PLUGIN_NAME

This is used to declare whether or not the plugin collects any user data. The result will be shown in Ultimate GDPR
& CCPA > Plugins.

Plugin Collects user data Compatible with Ultimate GDPR
Contact Form 7 Yes Yes
Ultimate GDPR Yes Yes
Events Manager Yes Yes
Yoast SEQ Probably No
CT SSL Fixer Unknown No
GA Google Analytics Unknown Mo
WPBakery Page Builder Unknown No
W3 Total Cache Unknown No

Example: Woocommerce Ultimate Discount plugin:

ct-woocommerce-ultimate-discount/ctUltimateDiscount.php

Declare to collect
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add_filter( "ct_ultimate_gdpr_controller_plugins_collects_data_ct—

—woocommerce-ultimate-discount/ctUltimateDiscount.php", '__ _return_
—true' );

Declare to not collect

add_filter( "ct_ultimate_gdpr_controller_plugins_collects_data_ct-—
—woocommerce-ultimate-discount/ctUltimateDiscount.php", '_ return_
—~false' );

3.1.1 Extend Functionality of Ultimate GDPR & CCPA for Plugin

You may extend functionality of Ultimate GDPR & CCPA by implementing services features for your plugin:

1. Extend php class CT _Ultimate_GDPR_Service_Abstract or implement the
CT_Ultimate_GDPR_Service_Interface interface

Example:

class CT Ultimate GDPR Service Contact Form 7 extends
CT_Ultimate_GDPR_Service_Abstract {
}

2. Implement required methods (some actions can be left empty)

3. Add an object of your service to the array of services to be registered in Ultimate GDPR & CCPA:

apply_filters( 'ct_ultimate_gdpr_load_services', array (), S$Soptions, Sthis—
—>services );

or, if you extended CT_Ultimate_ GDPR_Service_Abstract, it will autoregister when instantiated.

4. To add options to admin, utilize WordPress Options API function ‘add_settings_field’ on ‘current_screen’ hook.
This is hook automatically in abstract class by the ‘add_option_fields’ function.

3.1.2 Adding New Controller to the Plugin

There is also a possibility of adding new controller (and therefore new menu page) to the plugin:

1. Either extend php class CT_Ultimate_GDPR_Controller_Abstract or implement the
CT_Ultimate_GDPR_Controller_Interface intefrace

Example:

class CT_Ultimate GDPR_Controller_ Forgotten extends
CT_Ultimate_ GDPR_Controller_ Abstract {
}
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2. Implement required methods (some actions can be left empty)

3. Add an object of your controller to the array of controllers to be registered in Ultimate GDPR & CCPA:

apply_filters( 'ct_ultimate_gdpr_controllers', array() );

4. To add a menu page, you can utilize ‘add_menu_page’ function if you extended the abstract class.

5. To add options to admin, please utilize WordPress Options API function ‘add_settings_field’

3.2 WP Super Cache Integration

By integrating WP Super Cache with Ultimate GDPR & CCPA, it will allow to save custom cookies.
Installation instruction for WP Super Cache
1. Create wp-super-cache-plugins folder in wp-content/plugins/ and add This file (remember to unzip it).
2. To make it work, do the following:
 Open wp-content/wp-cache-config.php and change the line under $wp_cache_plugins_dir:

From:

>
‘T
O
C
1

WPCACHEHOME . 'plugins';

To:

swp_cache_plugins_dir WP_CONTENT_DIR . "/plugins/wp-super—-cache-

—plugins/";;

e In result, on Plugins page of WP Super Cache settings (/wp-admin/options-
general.php?page=wpsupercache&tab=plugins) you will have only one plugin: this plugin,
called Ultimate GDPR - WP Super Cache integration

3. Follow the instruction on the page /wp-admin/options-general.php?page=wpsupercache&tab=plugins.

3.3 Other Integration

3.3.1 Adding Fields to wp_admin

* add_option_fields() - Function used to add fields to wp_admin. A good example of usage is in class service-
contect-form.php or service-bbpress.php

3.3.2 Plugin with Forms
* front_action() - If plugin has forms (for example contact form) you should add a function which injects consent
checkbox which allows processing of data. You should add checkbox template to plugin’s hooks.

Do not forget about validation for this field. You can use service-bbpress.php::front_action() as an
example.
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3.3.3 If plugin stores any user data

If plugin stores any user data you should implement following functions:
¢ collect() - collects data stored by plugin
¢ is_forgettable() - must return true
* forget() - handle removing data stored for given user

* breach_recipients_filter() - usually gets all users whose data is stored by plugin

3.3.4 If plugin creates cookies

* If plugin creates cookies you should list them like in service-google-analytics.php::cookies_to_block_filter().

I's a good 1idea to «copy this function and update cookie names and
CT _Ultimate_GDPR_Model_Group::LEVEL _

3.3.5 If plugin adds cookies

¢ If plugin adds cookies using js functions, use script_blacklist_filter().

It’s similar to cookies_to_block_filter(). Instead of cookie names, use some unique string which
appears in the code.
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CHAPTER 4

Common Issues

4.1 Incompatible with the Theme

There are thousands of plugins that are compatible with WordPress. Ultimate GDPR & CCPA is coded to be compati-
ble with themes that are using WordPress Coding Standards, but some themes and plugins do not follow this standards
and may cause issues with compatibility.

These are some steps to troubleshoot if there’s error/s when Ultimate GDPR & CCPA is activated:

Note: Create a Backup for your site before doing these steps to prevent any issue with your site.

Check for Theme Conflicts
* Change into a default WordPress theme and check if the issue still persist.
* If the issue doesn’t persist, the issue is caused by the theme.

« If the issue still persist, please proceed with Check for Plugin Conflicts.

4.2 Incompatible with Plugins

With the thousands of plugins that are available, one or more plugins have a chance to conflict with Ultimate GDPR
& CCPA. We’re doing our best to integrate plugins user’s are using that are in conflict with Ultimate GDPR & CCPA.

To know which plugin is causing the conflict, follow this instructions:
Check for Plugin Conflicts

¢ Disable all the plugins except for Ultimate GDPR & CCPA. Check if the issue is there, if not proceed with these
instruction.

» Activate plugins one at a time. After activating a plugin, check if the issue is there.

« If the issue is not there, deactivate the plugin again and activate another plugin. Repeat this process until the
issue is recreated.

* If the issue is there, then this issue is due to this plugin.
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 Check the plugin’s settings if there is a setting that is making the conflict with Ultimate GDPR & CCPA.
For premium plugin integration, share test access to website with the mentioned plugin for faster integration.

You can also manually integrate plugins by following these instructions.

4.3 Cookie Consent always visible

There are many factors that may affect the cookie consent from always showing.
These are some of the reasons why this happens:

* In most cases this is due to a caching plugin / caching module enabled in the server. Currently we have inte-
gration on most popular cache plugin (like WP Rocket Plugin). If you are using a caching plugin that is not
integrated, the solution might be:

1. Go to the Caching Plugin’s settings and search for the option to “allow cookies”.
2. Add “ct-ultimate-gdpr-cookie” to allow GDPR cookies.

¢ Option in Ultimate GDPR & CCPA > Cookie Consent > Advanced settings - ‘Show advanced cookie popup
always, even when the consent is given’ is enabled. This will show the trigger for the Cookie Advance Settings.

* Your server is running with old PHP version (<PHP 5.6) which causing the script to fail. Upgrading the server’s
PHP version will make the site secure and advanced.

— To check what the PHP Version of the server, read this page: LINK
— To update the PHP Version of the server, read this page: LINK

 There are javascript errors on your site (caused by other plugins/theme) which are causing the conflict.

4.4 Issues with 3rd Party Plugin

4.4.1 After Accepting Cookie consent, popup is still visible

This issue might be due to a Cache plugin that is used in the site. To resolve this issue, please exclude the ‘ct-ultimate-
gdpr-cookie’ cookie from cache in the Caching plugin. Most of the Caching plugins have this option available, if you
have problems finding it in the plugin, please contact the support of the Cache plugin.

WP Rocket Plugin

Accept cookies

» For issues where user have set to accept cookies but user still gets notice on every/selected pages,
please check your Ultimate GDPR & CCPA version. This issue should be resolve from Ultimate
GDPR & CCPA version 1.6.1 onwards.

Note: For full compatibility with the WP Rocket (which require saving the WP Rocket’s configurations
files) make sure to either save WP Rocket options or save Ultimate GDPR & CCPA options (any) while
Ultimate GDPR & CCPA plugin is active.
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Cookie Consent is not Saved

W3 Total Cache
» Using W3 Total Cache plugin to enable cashing.

* Go to Cookie Groups of W3 Total Cache and look for cz_ultimate_gdpr_cookie. Click on Enabled, uncheck
Cache, and add ct-ultimate-gdpr-cookie in Cookies.

SEQ
Group name: 4. ct_ultimate_gdpr_cookie pelete group
WP Mail Log
7 WP Security
Enabled:
Quick Redirects —
! Performance Cache: 0
~
board
Cookies: ct-ultimate-gdpr-cookie

—

eferrer Groups

T EEES Specify the cookies for this group. Values like 'cookie’, ‘cookie=value', and coo
Save all settings

MNote(s):

® Content is cached for each group separately.

® Per the above, make sure that visitors are notified about the cookie as per any regulations in your marke

4.5 Fatal Error Fix

For issues with this error:

Error: Fatal error: Cannot redeclare tgmpa() (previously declared in home/siteURL/public_html/wp-
content/plugins/ct-ultimate-gdpr/vendor/optimus-prime-plugin-update/class-tgm-plugin-activation.php:2127)  in
home/siteURL/public_html/wpcontent/themes/personal_folder/inc/plugins/class-tgm-plugin-activation.php
on line 2118

Fatal error: Cannot redeclare tempa() (previously declared in /home; public_html 1 lugin-updatecl 1
: ; 1y declarec

I v o primus-prime-plug m-plug php:2127) in /home, I public_btmlwp-
pl vation.php on line 2118

A plugin to resolve this issue is created. To get this plugin, click on: Ultimate GDPR & CCPA Fix

Install and activate this plugin.

4.5. Fatal Error Fix 127


http://assets.themeforest.createit.pl/download_files/Ultimate_GDPR/ct-ultimate-gdpr-tgmpa-fix.zip

Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

Appearance

& Plugins @

Ultimate GDPR
Deactivate

Complete General Data Protection Regulation compliance toolkit plugin for WordPress,

Version 1.5.4 | By CreatelT

Installed Plugins Ultimate GDPR Fix

Deactivate

Add New

Fix for http://www.mykanosadonis.gr

Version 1.0 | By CreatelT

4.6 Cookie Scanner

4.6.1 Google Analytics

To exclude cookie scanner traffic from your Google Analytics, you can use Exclude URL Query Parameters option

for your Google Analytics.
To do that:

1. Log in to Google Analitycs and go to Admin > View > View Settings.

2. In field “Exclude URL Query Parameters” add “ctpass” (without quotes).

Q ADMIN USER
ﬁ UL - Create View
Your view name
[ 1}
.-—
- B view settings

b
[

User Management

F Goals

A Content Grouping

Y Filters

T 0O Y

E Channel Settings

L}

™ Ecommerce Settings

PERSONAL TOOLS & ASSETS

Segments

[Z] Annotations

ilit Attribution Models

Dd calculated Metrics seTa

View Settings

Basic Settings
View ID
1337043075
View Name

Your view name

Website's URL

https:f ~  www.yourdomain.com

User-ID Reports
Disabled

Time zone country or territory

United States (GMT-07:00) Pacific Time -

Default page opticnal

Exclude URL Query Parameters optional

CtEaSS
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4.6.2 Plugin created gdpr-dummy@createit.pl account

The gdpr-dummy @createit.pl is a dummy account which allows from (1.6.6) version of the plugin to gather all the
cookies that are on the website using ‘Scan for cookies’ option. The purpose of the dummy account is to activate the
cookies which normally would only show when some action is made on the pages (for example added product to cart.)

This account should be removed after the scan of the site is done. If you don’t want it to be constantly created, on path
Ultimate GDPR & CCPA > Cookie Consent - Preferences change the “Choose how often cookie scans should be
performed” to Never. It will stop the plugin from creating this account constantly.

Cookie popup Preferences Advanced settings

Cookie check

Choose how often cookie check should

Never v
be performed
Choose default level of new cookies Essential v
Cookies whitelist (never block these PHPSESSID, wordpress, wp-settings-,
cookies, comma separated) __cfduid, ct-ultimate-gdpr-cookie

Pd

Block selected/all cookies until user
consents

Set consent expire time [s] 31536000

4.7 Advanced Custom Fields (ACF) Conflict

Plugins and themes which uses ACF may conflict with Ultimate GDPR & CCPA plugin.

To resolve this issue, you can add this plugin, Ultimate GDPR ACF Fix, to your site.
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B NEwW Version of Siider Revalution 15 Bvanaple.
Ultimate GDPR Complete General Data Protection Regulation compliance toolkit plugin for WordPress.
Deactivate | Translate Version 1.6.3 | By CreatelT
Ultimate GDPR ACF Fix Do not filter default ACF paths
Deactivate | Translate Version 1.0 | By CreatelT
WooCommerce An eCommerce toolkit that helps you sell anything. Beautifully.

Seftings | Deactivate | Translate Version 3.4.3 | By Automattic | View details | Docs | API docs | Premium support
WooSidebars Replace widget areas in your theme for specific pages, archives and other sections of WordPress.
Activate | Translate Version 1.4.5 | By WooCommerce | View details

This will resolve the conflict with Ultimate GDPR & CCPA’s use of ACF with the plugin or premium theme that also
uses ACF.

Themes using ACF
* MyListing Theme
Plugins using ACF

¢ WooCommerce Attach Me!

4.8 Missing information about available update

If the information about the available update is missing from your plugin section or you wish to always be sure you
are using the latest version of the Ultimate GDPR & CCPA plugin please add:

add_filter( ‘auto_update_plugin’, ‘__return_true’ );

to functions.php file, which will allow all the pages used by the site to auto-update instead of having to click the
‘update link’.
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CHAPTER 5

Plugin Translation

5.1 Translate GDPR & CCPA Plugin

5.1.1 How to translate cookie popup

Cookies To make this site work properly,
we sometimes place small data files
called cookies on your device. Most big
websites do this too.

Cookies Settings

To translate the cookie popup of the Ultimate GDPR & CCPA plugin, you can use the PO and MO files in the plugin
to translate it. Click here for instructions how.

You can also use plugins to translate it, like WordPress Multilingual Plugin (WPML Plugin) or Loco Translate.

Note: Fill in with default content for selected language (remember to save changes), translates the default
contents in the Cookie Popup Content of the plugin. These will generate the translations of the default contents, if you
have changed any of the text content it will not be translated.

These are the parts that will be translated:
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Cookies

Damit dieses Internetportal
ordnungsgemal funktioniert, legen wir
manchmal kleine Dateien - sogenannte
Cookies — auf lhrem Gerat ab. Das ist bei
den meisten groBen Websites ablich.

Cookies akzeptieren

Lesen Sie mehr

Cookies-Einstellungen
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5.1.2 How to translate Advance cookie settings

PRIVACY SETTINGS

Decide which cookies you want to allow. You can change these settings at any time. However, this can result in some
functions no lenger being available. For information on deleting the cookies, please consult your browser’s help function.

Learn more about the cookies we use.

WITH THE SLIDER, YOU CAN ENABLE OR DISABLE DIFFERENT TYPES OF
COOKIES:

%) <\/ {§}> p=.

Block all ssentials Functionality Analytics Advertising
L]

THIS WEBSITE WILL THIS WEBSITE WON'T
Essential: Remember your cookie permission setting Analytics: Keep track of your visited pages and
Essential: Allow session cookies interaction taken
Essential: Gather information you input into a contact Analytics: Keep track about your location and region
forms newsletter and other forms across all pages based on your IP number
Essential: Keep track of what you input in shopping Analytics: Keep track on the time spent on each page
cart Analytics: Increase the data quality of the statistics
Essential: Authenticate that you are logged into your functions
User account Advertising: Tailor information and advertising to your
Essential: Remember language version you selected interests based on e.g. the content you have visite
Functionality: Remember social media settings befare. (Currenty we do not use targeting or targeting
Functionality: Remember selected region and country cookies)

Advertising: Gather personally identifiable information

such as name and location

To translate the Advance cookie settings of the Ultimate GDPR & CCPA plugin, if you’re using the default content go
to Ultimate GDPR & CCPA > Cookie Consent > Cookie popup tab.

In Cookie popup content, choose the language you want to use in Fill in with default content for selected language
(remember to save changes).

Load the language and you will see that the text areas for the contents have the default content translated. Click Save
Changes to save.
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You can also use plugins to translate it, like WordPress Multilingual Plugin (WPML Plugin) or Loco Translate.

Note: When using this option all the changes have added/changed in the text content will revert to the default content
of the language you have chosen. To prevent the reversion, use this method then make the changes.

PRIVATSPHARE-EINSTELLUNGEN

Entscheiden Sie, welche Coockies Sie zulassen méchten.
Sie konnen diese Einstellungen jederzeit andern. Dies kann jedoch dazu fuhren, dass einige Funktionen nicht mehr zur
Verfligung stehen. Informationen zum Léschen der Cookies finden Sie in der Hilfe lhres Browsers.

ERFAHREN SIE MEHR UBER DIE VON UNS VERWENDETEN COOKIES.

MIT DEM SCHIEBEREGLER KONNEN SIE VERSCHIEDENE ARTEN VON COOKIES
AKTIVIEREN ODER DEAKTIVIEREN:

alles blockieren Wesentliches Funktionalitat Analytik Werbung
()
DIESE WEBSITE WIRD DIESE WEBSITE WIRD NICHT
Wesentlich: Erinnern Sie sich an lhre Cookie-Erlaubnis- Merken 5Sie sich lhre Zugangsdaten
Einstellung Funktionalitat: Merken Sie sich die Einstellungen fur
Wesentlich: Sizungscookies zulassen Social Media
Wesentlich: Sammeln Sie Informationen, die Sie in Funktionalitat: Ausgewahite Region und Land merken
einen Kontaktformular-Newsletter und andere Analytics: Behalten Sie den Uberblick tber Ihre
Formulare auf allen Seiten eingeben besuchten Seiten und Interaktionen
Wesentlich: Behalten Sie den Uberblick Ober |hre Analytics: Verfolgen Sie [hren Standort und Ihre Region
Eingaben im Warenkorb anhand Ihrer IP-Nummer
Wesentlich: Authentifizieren Sie sich, dass Siein lThrem Analytics: Behalten Sie die auf jeder Seite verbrachie Zeit
Benutzerkonto angemeldet sind im Auge
Wesentlich: Die gewahlte Sprachversion speichern Analytics: Erhdhen Sie die Datengualitat der

Statistikfunktionen
Werbung: Passen Sie Informationen und Werbung an

Ihre Interessen an, 2.B. aufgrund der von Ihnen
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5.1.3 How to translate forms

ZAPOMENTE NA MNE

NiZe se mlZete podivat na sluZby, které sbiraji vaZe osobni data na této strance. Zaskrtnéte sluzby,
u kterych chcete byt zapomenuti. Odesle se poZadavek administratorovi stranky. O dokonceni
budete upozornéni e-mailem.”

WooCommerce
WooCommerce gathers data entered by users in shop orders

WP Comments
WeordPress Comments are data entered by users in comments

WordPress Posts
WerdPress posts author data

WP User Data
WordPress user data stored as user meta data in database

i
T
o
iT
(=}
.l

w
w
1]
]

ODESLAT

There are 2 ways to translate the form: Translate Default Text or Translate Manually

¢ Translate Default Text

To translate the forms of the Ultimate GDPR & CCPA plugin, you can use the PO and MO files in
the plugin to translate it. Click here for instructions how.

To use the translation of the default text in the forms, go to Ultimate GDPR & CCPA > Services.

Delete the text inside the textbox for description on the service that you wan’t to be translated.
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WooCommerce a

[WooCommerce] Nazev

[WooCommerce] Popis

[WooCommerce] VioZit checkbox do
objednavkového formuléfe

[WooCommerce] VlioZit zaskrtavaci pole
se souhlasem k formulafim aétu

[WooCommerce] Zaskrinéte policko
souhlas s checkout

WooCommerce i

Muo(ummerce gathers data entered by users in shop urders\

¢ Translate Manually

For example, WooCommerce:

To translate the forms manually, go to Ultimate GDPR & CCPA > Services. Go to the service that
you wan’t to be translated.

Add the translation in the textbox for description.

WooCommerce o

[WooCommerce] Nazev

[WooCommerce] Popis

[WooCommerce] VloZit checkbox do
objedndvkového formulare

[WooCommerce] VloZit zaskrtavaci pole
se souhlasem k formularim aétu

[WooCommerce] Zaskrtnéte policko
souhlas s checkout

WooCommerce P
4

WooCommerce shromaZzduje udaje zadané uzivateli v objednavce cbchodu\
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You can also use plugins to translate it, like WordPress Multilingual Plugin (WPML Plugin) or Loco Translate.

ZAPOMENTE NA MNE

Nize se muzZete podivat na sluZby, které sbiraji vage osobni data na této strance. Zagkrtnéte sluzby;,
u kterych chcete byt zapomenuti. Odesle se poZadavek administratorovi stranky. O dokonéeni
budete upozornéni e-mailem.”

WooCommerce
WooCommerce shromazduje Udaje zadané uzivateli v objednavee obchodu

WP Comments
WordPress Comments uklada ddaje zadané uzZivateli v kementafich

WordPress Posts
WordPress zverejnuje data autora

WP User Data
Uzivatelska data aplikace WordPress jsou uloZzena jako uZivatelska meta data v databazi

ODESLAT

5.2 Multilingual website
For Multilingual websites, you can use plugins to translate GDPR & CCPA to 2 or more languages.

5.2.1 WordPress Multilingual Plugin (WPML Plugin)

To use this option, you need to have installed WordPress Multilingual Plugin (WPML Plugin), which you can buy
here.

Note: This plugin isn’t part of the GDPR & CCPA Plugin bundle, to use this function you must have the WPML
Plugin.

Follow how to translate using WordPress Multilingual Plugin (WPML Plugin).

5.2.2 Loco Translate

Loco Translate is a free plugin for translation, which you can download here.
Loco Translate will use the PO and MO file to translate the plugin.

Follow how to translate using Loco Translate.
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5.2.3 How to translate “Privacy Policy” text in the consent checkbox

Additional Information

Order Notes (Optional)

Notes about your order, e.g. special notes for delivery.

~ IConsent To The Storage Of My Data According To The|Privacy Policy *

For multilingual sites, the Privacy Policy link in the consent checkbox needs to be manually translated in Ultimate
GDPR & CCPA > Privacy Policy under Convert the following text to Privacy Policy link in all services templates,
eg. ‘Privacy Policy’.

Last visited page r

Contact
Size guides
(IETTAUN Shortcode Button Styling Theme Default v
Products
WaitList

Set consent expire time [s] 31536000
Appe:
Plugins
Users

Privacy Policy version, eg. 1.0 (if you change it, user has to give 1.0
Tools consent again)

WPBakery Page
Builder

Redirect to Privacy Policy first (if Terms and Conditions also redirect) Enable Disabled

Custom Fields

Ultimate GDPR

Convert the following text to Privacy Policy link in all services Privacy Policy
templates, eg. ‘Privacy Policy'

Do not block user agents (eg. bots) containing the following texts bot, crawl, slurp, spider, mediapartners
(comma separated)

Privacy Palicy

Press "Save changes” before downloading logs if you changed any options

Save Changes

Download consents log

Thank you for creating with WordPress, Version 4.9.7

Add the translations, separated by a comma, for every language that is used in the site.

Convert the following text to Privacy Policy link in all services | Privacy Policy, Datenschutzerkldrung, Politique de confidentialité, Politica de privacidad
templates, eg. “Privacy Policy’

Sample in Spanish:

Sample without translation set:
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Additional Information

Notas Del Pedido (Opcional)

Notas sobre tu pedido, por ejemplo, notas especiales para la entrega.

(]
Consiento El Almacenamiento De Mis Datos De Acuerdo Con La Politica De Privacidad *

Sample with translation:

Additional Information

Notas Del Pedido (Opcional)

Notas sobre tu pedido, por ejemplo, notas especiales para la entrega.

(]
Consiento El Almacenamiento De Mis Datos De Acuerdo Con LulPoliticu De Privacidad *l

5.2.4 How to translate Enter custom subheader for ‘Unsubscribe’ tab in ‘my ac-
count’ shortcode

AGE VERIFICATION PERSONAL DATA ACCESS FORGET ME DATA RECTIFICATION UNSUBSCRIBE

Removal of your data will not limit in any way the system functionalities

Below, you can browse services which sign up users to newsletters. Check services which newsletters
you wish to be unsubscribed from. The subscription will stop immediately.

Do not sell my information

Request not to sell personal information

Email:

| consent to have my email collected in order to process this request. See Privacy Policy page for more
information.

SUBMIT

Single language website

If the site uses only one language version and it is not English, the only way to use the phrase in the correct language is
to enter it directly to the textarea available on path *Ultimate GDPR & CCPA > Unsubscribe > Enter custom subheader
for ‘Unsubscribe’ tab in ‘my account’ shortcode (or leave empty for default content)
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Set custom URL to the page
containing Ultimate GDPR

shortcode as the email
confirmation target page (or leave
empty for autodetect)

Enter custom subheader for
‘Unsubscribe' tab in "my account’
shortcode (or leave empty for
default content)

Multilingual website

To translate this phrase for a multilangual page please follow WordPress Multilingual Plugin (WPML Plugin).

5.3 Translate Using POT file

To translate the plugin, it will need a POT (Portable Object Template) file to work.

POT is generated from plugin files and contain all phrases from the plugin that can be translated to a different language.

Note: The POT file for this plugin is ct-ultimate-gdpr.pot, and the path to it is /wp-content/plugins/ct-ultimate-
gdpr/lang/
Awplwp-content\plugins\ct-ultimate-gdprilang w | Q| | Searchlang
e MName . Date modified Type Size
# Jgitkeep 21/06/2018 T:13 PM  GITKEEP File 0 KB
» I m ct-ultimate-gdpr 27/06/2018 12:00 Translation Temnpl 130 KE I
D ct-ultimate-gdpr-cs_CZ 27/06/2018 12:00 Compiled Translat 52 KB
D ct-ultimate-gdpr-cs_CZ 27/06/2018 12:00 PO Translation 155 KB
D ct-ultimate-gdpr-cs_CZ-backup-2018062... 27/06/2018 3:30 PM PO~ File 100 KB
D ct-ultimate-gdpr-de_DE 27/06/2018 12:00 Compiled Translat 49 KB
D ct-ultimate-gdpr-de_DE 27/06/2018 12:00 PO Translation 157 KB
D ct-ultimate-gdpr-de_DE-backup-2018062... 5/2018 3:48 PM - PO~ File 101 KB
D ct-ultimate-gdpr-es_ES 7/06/2018 12:00 Compiled Translat S0KB
D ct-ultimate-gdpr-es_ES 27/06/2018 12:00 PO Translation 160 KB
D ct-ultimate-gdpr-es_ES-backup-2018062...  27/06/2012 3:45PM PO~ File 103 KB
D ct-ultimate-gdpr-fr_FR 27/06/2018 12:00 Compiled Translat 29 KB
D ct-ultimate-gdpr-fr_FR 27/06/2018 12:00 PO Translation 161 KB
D ct-ultimate-gdpr-fr_FR-backup-20130627... 5/2018 3:06 PM PO~ File 105 KB
D ct-ultimate-gdpr-hr 7/06/2018 12:00 Compiled Translat 49 KB
D ct-ultimate-gdpr-hr 27/06/2018 12:00 PO Translation 156 KB
D ct-ultimate-gdpr-hr-backup-2013062709...  27/06/2018 5:40 PM PO~ File 101 KB
D ct-ultimate-gdpr-hu_HU 27/06/2018 12:00 Compiled Translat 51 KB
) D ct-ultimate-gdpr-hu_HU 27/06/2018 12:00 PO Translation 164 KB
(& [T ct-ultimate-gdpr-hu_HU-backup-201806...  27/06/2012 5:00 PM PO~ File 103 KB
Yiw D ct-ultimate-gdpr-it_[T 27/06/2018 12:00 Compiled Translat 43 KB
v D ct-ultimate-gdpr-it_[T 27/06/2018 12:00 PO Translation 136 KB
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The translation editor will create PO (Portable Object) and MO (Machine Object) file from the plugin POT file. The
only file we are able to edit is the PO file.

In the PO file, we are saving both English and the translations for this phrases. All translations you created are added
there. Saving the changes there will also update the MO file that is used by the plugin.

5.3.1 How to translate plugin using Poedit

Note: To ensure that plugin will work correctly, don’t translate the string Ultimate GDPR & CCPA
plugin.

« Install a translation editor like Poedit.

Copy the ct-ultimate-gdpr.pot file from /wp-content/plugins/ct-ultimate-gdpr/lang/. Paste it on the desktop of
your computer.

Open the Poedit application and click on Create new translation option.

Choose the PO file to translate.
&

File Edit View Catalogue Go Help

Open

Upgrade to Pro
5| Open catalogue template x
4 > ThisPC 5 Desktop » v | @ | Search Desktop ¥
Organise v New folder = M @
-
s Quick access fi ct-ultimate-gdpr
0 | PO Translation
[ Desktop A 29.8KB
¥ Downloads

[ Documents

=] Pictures
_image
religia
watersports

weddington
@ OneDrive
[ This PC
J 3D Objects
[ Desktop

= Documents h

File name:

\( PO Translation Files (*.po) -

What is Crowdin?

* You will be ask what language to translate the file into, choose the language as to what you need.
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File Edit View Catalogue Go Help
Open Save | [ Validate (% Statisics 5 Pre-translate Upgrade toPro [N |

Source text — English Translation — unknown language T e s
Max Mega Menu is net compatible with your version of WerdPress. ...

Max Mega Menu is net compatible with Uber Menu, Please disable ...

click here

Thanks for installing Max Mega Menu! Please %s to get started.

regenerate the C5S

Max Mega Menu Updated. Please %s to ensure maximum compatib...

Mega Menu

Mega Menus can only be created on top level menu items.
Enable Mega Menu

column

columns

Select a Widget to add to the panel

Sub menu items

Widgets

No widgets found. Add 3 widget to this area using the Widget Selec] Language of the translation:

Translation Language X

Menu Item Settings

Hide Text

Option only available for top level menu items Cancel
Hide Arrow

Disable Link

Blaris lbam Alian

Source text:

Max Mega Menu is not compatible with your version of WordPress. Please upgrade WordPress to the latest version or disable Max Mega Menu.

Translation: Needswork @)

Add comment

Translated: 0 of 260 (0 %) - Remaining: 260

* You will see at the Poedit application that at the left side are the Source Text (English words) and at the right
side are the Translations.

e When you click on a word from the source text, at the very right side you will see Translation Suggestions for
the word that was clicked.

* You can add your translation at the Translation: area at the bottom or click on the best of the suggested
translations of the word.

Fle Edit View Catalogue Go Help
Open [B) Sewe | [ Velidate (3 Sttisics Ty Pretransiete (3 Update Upgrade toPro Il ]

Source text — English

Thanks for installing Max Mega Menu! Please %s to get started.

Translation suggestions:

regenerate the CS5
Max Mega Menu Updated. Please %s to ensure maximum compatib... 2 pulsa aqui
Mega Menu Ctrl+2 » 100%

Mega Menus can only be created on top level menu items. & clicaqui
Ctri+3 -1

Enable Mega Menu
column . El iltimo paso es actuslizar e plugin de
Realtyspace a una nueva version. <a

columns href="%s"> Clic aqui para proceder</a> y
Select a Widget to add to the panel presione "Update".

Sub menu items No se preocupe, este
Widgets mensaje es visible slo para usted.

No widgets found. Add a widget to this area using the Widget Selec.. Gl - 100%

Menu ltem Settings & Click aqui
5.
Hide Text Ctri+5
Option only available for tap level menu items 2 dickagu
Hide Arrow Ctri=6+1
Disable Link & presione aqui
i Ctrl+7 - 100%
Menu ltem Align
Left
Rinht &
Source text:
click here
Translation: Needswork (@)

haga clic aqui

Add comment

Translated: 1 of 260 (0 %) - Remaining: 259
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* Click on a word from the source text one by one and translate.

* Once done translating the words in the Source text, save the file.

* When saving a file, “ct-ultimate-gdpr-" should be added to the default file name.

Open [F) Seve | [ Welidate (5 Stetistics’ ¥y Prectrnshate £ Update Upgrade toPro [l ]
Source text — English Translation — Spanish Translation suggestions:
click here haga clic aqui
Tk £ 5 e . x
regen
Max 4 MW > ThisPC » Desktop » v ®| | SearchDeskiop r
Mega
Mega| Organise = New folder = @
Enable g Desktop ~
colum| ct-ultimate-gdpr ct-ultimate-gdpr-es
n gdp i gdp
colum ¥ Downloads 0 | POTranslation i | POTranslstion
Select % Decuments A | 298k8 i | x9ke
Subm ) Pictures
Widge image
No wi |
religia
Meng Result
Hide T watersports
Optie weddington
Hide A
Dissbl|  # OneDrive
M
= ThisPC
Left
Rinht 30 Objects add ct-ultimate-gdpr-
Sourcete |l Desktop
click here, = Darimente v
File name” = | -
Save sz type: PO Translation Files (*.po) ~
Translatiq  Hide Folders Cancel
haga clic squi
Add comment
Translated: 1 of 260 (0 %) « Remaining: 258

¢ Once saved, it will create a PO and MO file.

* Copy the PO and MO file to the WordPress language directory located at /wp-content/languages/plugins/.

5.3. Translate Using POT file
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Share View 0
u o Cut x Eﬁ I New item ~ B open ~  FH selectan
w-| Copy path * ﬂ Easy access ~ Edit 10 Select none
‘aste Move Copy Delete Rename Mew Properties
[#] Paste shorteut tov  tow - folder - 2 History EF Invert selection
poard Crganise New Cpen Select
p-contentilangua LE hl | O | Searchplugins P
" Name - Date modifie Type Size ~
|| contact-torm-/-hu_HU 3 A g Lompiled Iranslat 41 Kb
- D contact-form-7-hu_HU PO Translation 56 KB
+ D contact-form-7-it_IT Compiled Translat
+ D contact-form-7-it_IT PO Translation
D contact-form-7-pt_PT _ Compiled Translat 40 KB
* D contact-form-7-pt PT 01/06/2018 215 PM PO Translation 54 KB
D ct-ultimate-gdpr-de_DE 30/05/2018 814 PM  Compiled Translat 41 KB
D ct-ultimate-gdpr-de_DE PO Translation 83 KB
D ct-ultimate-gdpr-es_ES Compiled Translat 42 KB
D ct-ultimate-gdpr-es_ES PO Translation 34KE
D ct-ultimate-gdpr-fr_FR Compiled Translat 43 KB
D ct-ultimate-gdpr-fr_FR PO Translation 35KB
D ct-ultimate-gdpr-hr 2018 8:20PM  Compiled Translat 39KB
D ct-ultimate-gdpr-hr 2018 8:20PM PO Translation 31KB
D ct-ultimate-gdpr-hu_HU 88:21 PM  Compiled Translat 51 KB
D ct-ultimate-gdpr-hu_HU 88:2 PO Translation 92 KB
D ct-ultimate-gdpr-it_IT Compiled Translat 41 KB
D ct-ultimate-gdpr-it_IT PO Translation 82KE
D ct-ultimate-gdpr-nl_NL Compiled Translat 3B KB
D ct-ultimate-gdpr-nl_NL PO Translation 31KB
D ct-ultimate-gdpr-pl_PL Compiled Translat KB
D ct-ultimate-gdpr-pl_PL PO Translation 35 KB
£ D ct-ultimate-gdpr-pt_PT Compiled Translat 32 KB
D ct-ultimate-gdpr-pt_PT PO Translation 156 KB
B W D ct-ultimate-gdpr-ro_RO Compiled Translat 41 KB W
lected 40.3 KB f3 =

¢ In your WP, activate the GDPR & CCPA plugin. Once activated, navigate your dashboard to Settings > General.

* You will see the General Settings of your site. To activate the translation, look for the Site Language and select
the one that you like.
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Site Language Espariol v

Timezone UTC+0 v

Choose either a city in the same timezone as you or a UTC timezone offset.

Universal time (UTC) is 2018-84-13 85:57:46 .

Date Format ®) April 13, 2018 F i, ¥
2018-04-13 Y-m-d
04/13/2018 m/d/Y
13/04/2018 d/m/y
Custom: FJ.Y

Preview: April 13, 2018

Time Format ®) 557 am g:ia
2:57 AM g:iA
05:57 H:i
Custom: gia

Preview: 5:57 am

Documentation on date and time formatting.

Week Starts On Monday v

Save Changes

* After selecting the site language, click the Save Changes button and a loading icon will show. Once the loading
icon disappear, the translation should be done.

For more information on how to translate a plugin using Poedit, click this link.

5.4 Translate Using WPML Plugin

To use this option, you need to have installed WordPress Multilingual Plugin (WPML Plugin), which you can buy
here.

Note: This plugin isn’t part of the GDPR & CCPA Plugin bundle, to use this function you must have the WPML
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Plugin.

To be able to fully integrate the translation functionality of WPML plugin:

¢ Install the WPML Plugin in your site. Once installed, activate these plugins:

ANl (84) | Active (8) | Inactive (76)

Bulk Actions ™ | Apply

Plugin Description
WeoCommerce Multilingual Allows running fully multiingual e-Commerce sites with WooCommerce and WPML Documentation.
Activate

Version 4.2.9 | By OnTheGosystems | View details

WPML Media Add multilingual support for Media files | Documentation | WPML Media Translation 2.2.1 release notes
Deactival= Version 2.2.1 | By OnTheGoSystems | Visit plugin site

WPML Multilingual CMS WPML Muttilingual CMS | Dacumentation | WPML 3.84 release notes
Deactivate | Configure Version 3.8.4 | By OnTheGosSystems | Visit plugin site

WPML String Translation Adds theme and plugins localization capabilities to WPML | Documentation | WPML String Translation 2.6.3 release notes
Deactivate | Configure Version 2.6.3 | By OnTheGoSystems | Visit plugin site

WPML Translation Management Add a complete translation process for WPML | Documentation | WPML Translation Management 2.43 release notes

Deactivate | Configure Version 2.4.3 | By OnTheGosSystems | Visit plugin site

Plugin Description

* You will be asked to setup the WPML Plugin after you have installed it.

Note: To be able to translate all the String content of GDPR & CCPA plugin, go to WPML > Theme and plugins
localization. In Localization options, choose any of the first 2 options in How to translate strings in themes and
plugins?.

Theme and plugins localization

Localization options

How to translate strings in themes and plugins?
Translate themes and plugins using WPML's String Translation enly (don't load .mo files)

®) Translate themes and plugins using WPML's String Translation and always load .me files as backup

Don't use String Translation to translate themes and plugins

Other options:

Use theme or plugin text domains when gettext calls do not use a string literal @

Assume that the original language of all strings is English

* Go to WPML > Theme and plugins localization, scroll down ang look for Ultimate GDPR & CCPA under
Strings in the plugins. Click the checkbox at the side and click on Scan selected plugins for strings button at
the bottom of the page.
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The Grid tg-text-domain 0
Theme Core ttg-core 0
Plugin
v Ultimate GDPR ct-ultimate-gdpr 3 create PO file
ct theme 0 create PO file
ct ultimate gdpr 0 create PO file
ct-ultimate-gpdr 0 create PO file
act 0 create PO file
Vit e wirhiial mmin wAdmsbe n

* This should scan all the string in the plugin.

e Go to WPML > String Translation, click on the drop-down box for Select strings within domain and look for
the domain for Ultimate GDPR & CCPA.

Note: The strings in Ultimate GDPR & CCPA are separated by parts.
— admin_texts_ct-ultimate-gdpr-cookie - The strings in the cookie advance settings.

— ct-ultimate-gdpr - Other string use by the plugin.
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Select strings within domain: | ct-yltimate-gpdr (1) v

(]

All domains -
acf (399)

Context Mame| akismet (&) =l
contact-form-7 (340)
continents-cities {438) i
ct_theme (101)
ct_ultimate_gdpr (8]
Context Mame| ct-catalog (8) -
ct-post-types-charlotte (5)
ct-size-guide (5]
ct-ultimate-gdpr (614)
ct-ultimate-gpdr (1)
ct-waitlist (6)
custom-sidebars ()
default {(3269)

depc (5)

envato-market (&)
estato-plugin (6)
formidable (368) hd

* You can click Display all results to show all the string available for translation.

¢ Choose a string to translate, click translations and add the translation of the string by language.

ct-ultimate-gdpr S submit Partial translation

translations.

French
Soumetrs
£

+| Translaticn is complete | Save

Polish

Zatwisrdi Y

Translation is complete | Save

* Once you are done translating, click the check box for Translation is complete then click the Save button for the
languages.
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admin_texts_ct-ultimate [ct-ultimate-gdpr-cocki Remember your login details
-gdpr-cookie e]cookie_group_popup_ translations
features_nonavailable,
o -4 Bulgarian
roup 5

3an0MHI BBUSTE faHsw 33 240

Translation is complete | Save

French
Se souvenir gz y5 ERfiR0t g8 canpexiRn

| Translation is complete | Saye

German

Iptkan Sz scb Loee Login-Daten

| Translation is complete | Save

* Go to Pages and create a new page for the translated pages. For the popup, once you have translated the strings,
it should automatically translate.

* If you already have pages created, click on the page created. Look for the Language section of the page. Click
on the plus sign for the language you would like translate. This will open a page to create a translated version
of the page of the language.

W
Language .

ky.craateit/memoniasite/privacy-policy/ | Edit

Language of this page

Frontend Editor 5
English ¥

r " Translate this Document
- Translate| Duplicate
[ ] Bulgarian +
French +
- ’ @ X German +

+ 7 X

Media attachments
Duplicate uploaded media to

is: http//ct7.phinky.createit/memoriasite. translations
Duplicate featured image to translations

ita we collect and why we collect it

* Go to Appearance > Menu and create a new menu for the pages.

* If you already have menus created, choose a menu to add to the translated language site. Click on Synchronize
menus between languages, Click on the Sync button.
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@ Dashboard Menus = Manage with Live Preview

A Posts EditMenus  Manage Locations

0 Media

M Pages Edit your menu below, or create a new menu

¥ Comments
English (1) | French | Poiisn

@) Events Menu Name  Main
Pages B
© FAQitems
. Language ~ English ¥
B Galleries Most Recent | View All  Search ZT5
Vi Jobs
— Home test
A Portfolio items admnBene Menu Structure
T Legal Base
[ Timeline items I Drag each item into the order you pr ck the arrow on the right of the item to reveal additional configuration options.
GDPR Plugin
Contact Data Access Form
GDPR Plugin Page ¥
# Appearance Add to Menu
. Personal Data Access Page ¥
hemes
omize Posts M
Legal Base Page ¥
Locations v
Admin Demo Page ¥
Events v
Documentation v
Faq items v
. i Gallery v
£ Plugins )
Menu Settings
& Users Jobs v
@ User Auto add pages Automatically add new top-level pages to this menu
# Tools o v locat . .
Portfolio items v Display location Breadcrumbs Navigation
@ WPBakery Page /| primary Navigation
Builder Timeline items M shop top navigation
Shop footer navigation
Settings Custom Links v

* You will see the changes on the site.

Sample English

PERSONAL DATA ACCESS FORGET ME

Email:

1 consent to my email being collected in order to receive my requested data. See Privacy Policy page for more information.

SUBMIT

Sample Polish

DOSTEP DO DANYCH OSOBOWYCH FORGET ME

Email:

Wyrazam zgode na odebranie mojej wiadomosci e-mail w celu otrzymania zagdanych danych. Zobacz strong Polityki prywatnosci, aby uzyskac wigcej informacji.

5.5 Translating using Loco Translate

Loco Translate is a free plugin for translation, which you can download here.
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Loco Translate will use the PO and MO file to translate the plugin.

To translate using Loco Translate Plugin, install and activate the plugin.

Performance Home

Slider Revolution Themes
Plugins
Mega Menu
WaordPress
Ultimate GDPR
Languages

Settings

Click Home to view all the translatable plugins and themes.

Choose Ultimate GDPR & CCPA under Bundle name then you will be redirected to a page with all the available
translations. You can create or edit a translation.

5.5. Translating using Loco Translate 151



Ultimate GDPR CCPA Compliance Toolkit for WordPress, Release 2.0.0

Active theme:

Bundle name

Estato Theme

See all themes =

Running plugins:

Bundle name

Slider Revolution

WPML Media

WPML Translation Management
WPEBakery Page Builder

Contact Form 7

Text domain

estato-theme

These plugins have recently loaded translation files into the admin area:

Text domain

revslider
wpml-media-translation
wpml-translation-management
J5_compaser

contact-form-7

Last modified

May 24, 2018 745 am

Last modified

May 24, 2018 7:51 am

March & 2018 12:12 am

June 1, 2018 11:58 am

Sets

Sets

%]

Ultimate GDPR

ct-ultimate-gdpr

May 31, 2018 1:38 pm

Custom Sidebars
WooCommerce

W3 Total Cache

Advanced Custom Fields PRO
WPL

WPML Multilingual CMS
WPML String Translation

Max Mega Menu

Loco Translate

custom-sidebars

woocommerce

w3-total-cache

acf

W
wp |

sitepress-multilingual-cms

wpml-string-translation

megamenu

loco-translate

June 4, 2018 11:08 am

June 4, 2018 11:08 am

June 1, 2018 11:58 am

May 30, 2018 9:56 am

May 24, 2018 7:531 am

June 1, 2018 11:58 am

June 1, 2018 11:58 am

ra

5.5.1 Edit a Translation

The languages you see here are the available PO and MO files for translating Ultimate GDPR & CCPA. It can be found
in your wordpress language folder or plugin folder.

To edit an existing translation, click on the language file you want to edit. You will be directed to the PO file with the
words that are translated and not translated.
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Plugins / Ultimate GDPR / ct-ultimate-gdpr-de_DE.po

Taxonomy sync problem

Editor Source File info Restore Delete

German Updated: May 30, 2018 12:14 pm - 81% translated, 451 strings (86 untranslated)

Source text Translation
Use advanced cookie groups popup
Version

You must accept the Privacy Policy before submitting the ...

ct-ultimate-gdpr-cookie-popup-button-large ct-ultimate-gdpr-cookie-popup-button-large
ct-ultimate-gdpr-cockie-popup-button-rounded ct-ultimate-gdpr-cookie-popup-button-abgerundet
ct-ultimate-gdpr-cockie-popup-modern ct-ultimate-gdpr-cookie-popup-modern
ct-ultimate-gdpr-cockie-popup-squared ct-ultimate-gdpr-cookie-popup-squared

Save | & Sync C' Revert || @ Fuzzy 1 <f> L po & MO

[%es] Description [%s] Beschreibung -

IE]1 Source text: Comments:

[%6s] Description

German translation:

[%as] Beschreibung

Click on a word/phrase that you would like to translate and add the translation below the Source Text under Language

Translation.

You will see a star icon indication beside the translated word/phrase that you have added/edited the translation.

Once you are done adding/editing the words/phrases in the translation, click on the the Save button to save the file.

5.5. Translating using Loco Translate
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Version
You must accept the Privacy Policy before submitting the form

ct-ultimate-gdpr-cockie-popup-button-large

ct-ultimate-gdpr-cookie-popup-button-rounded

ct-ultimate-gdpr-cockie-popup-modern

ct-ultimate-gdpr-cookie-popup-squared

You must accept the Privacy Policy before submitting the form

ct-ultimate-gdpr-cookie-popup-button-large

ct-ultimate-gdpr-cookie-popup-button-abgerundet
ct-ultimate-gdpr-cookie-popup-maodern

ct-ultimate-gdpr-cookie-popup-squared

Editor Source File info Restore Delete
@ Notice: Changes to this file may be overwritten or deleted when you update WordPress. Documentation | Settings €3
German Updated: May 30, 2018 12:14 pm — 81% translated, 451 strings (84 untranslated)
- 2 sync || C Revert || & Fuzzy L] <> ro & MO
Source text Translation
Version -

[%6s] Description [%6s] Beschreibung

-

921 Fntar the avictinn nzar's amail whnm the nncte will he rea %<l (Gehan Sia dia F-Mail-Adracca dec RBaniitrare ain dam die R

E] Source text: Comments:

ct-ultimate-gdpr-cookie-popup-button-rounded

German translation:

ct-ultimate-gdpr-cockie-popup-button-abgerundet

5.5.2 Create New Translation

To create a new translation, you click on the New Language link below the Ultimate GDPR & CCPA word.

Overview Setup Advanced

Ultimate GDPR (ct-ultimate-gdpr)

@ Mew language | @ Create template

Language Translation progress
German
1 81%
= Hungarian
I oo
I 1 Italian —
[ =t st

You will be redirected to an option for the template of the PO file. You can opt to Create Template or Skip template.
Creating a template will make this the default template for all your translations of Ultimate GDPR & CCPA in Loco
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Translate.

Note: The created template will be updated by clicking the Edit template link beside new language and click on the
Sync button. If there is a new/updated version of the template, this will sync with the template that is in the plugin
folder.

Creating a new translation, you will be redirected to Initializing new translations in “ct-ultimate-gdpr” where you can
choose what language you would like to make a translation and choose a location where you would like to save the
file made.

Initializing new translations in “ct-ultimate-gdpr"

298 strings found in ct-ultimate-gdpr.pot

1. Choose a language: ® | WordPress language: Custom language:

Gearman v

2. Choose a location:

Custorm: ®) languages/loco/plugins/ct-ultimate-gdpr-de_DE.po
System: languages/plugins/ct-ultimate-gdpr-de_DE.po
Author: plugins/ct-ultimate-gdpr/ct-ultimate-gdpr-de DE.po

Start translating

Click on the Start translating button and you will be redirected to translating area with the source text and a blank
translation.

Same as editing a translation, click on a word/phrase that you would like to translate and add the translation below the
Source Text under Language Translation.

You will see a star icon indication beside the translated word/phrase that you have added/edited the translation.

Once you are done adding/editing the words/phrases in the translation, click on the the Save button to save the file.

5.6 Downloads for Language Version

Ultimate GDPR & CCPA Plugins is pre-packed with several language versions available for download below.
¢ German (version 2.6)
¢ French (version 2.6)
* Spanish (version 2.6)

* Norwegian (version 2.6)
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Russian (version 2.6)
Polish (version 2.6)
Italian (version 2.6)
Dutch (version 2.6)
Croatian (version 2.6)
Hungarian (version 2.6)
Romanian (version 2.6)
Czech (version 2.6)
Slovak (version 2.6)
Portugese (version 2.6)
Danish (version 2.6)

Bulgarian (version 2.6)

Can’t find your language? Write us an email to support @ createit.pl — we’re constantly improving.
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CHAPTER 6

Compatible Plugins

6.1 Compatible with GDPR & CCPA

6.1.1 Unintegrated Plugins

Plugins that are not integrated with Ultimate GDPR & CCPA may not function as expected or may create a conflict.

We do strive to integrate plugins that our users use. We’re constantly add new features, assuring compatibility with
major plugins ang themes.

6.1.2 Integrated Plugins

Plugins that are integrated have full compatibility with Ultimate GDPR & CCPA.
The following plugins are officially integrated:

¢ Advanced Custom Fields

* bbPress

* BeaverBuilder

* BuddyPress plugin

* Caldera Forms

¢ CleanTalk Plugin

* Contact Form7

* Disqus Conditional Load

* Facebook Pixel

¢ Flamingo Plugin

* Flatsome UX Builder

* Formidable Forms

* GA Google Analytics

* Google AdSense

¢ Google Ads

¢ Google Analytics
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Gravity Forms

Klaviyo

LiteSpeed Cache

MailPoet Newsletters plugin
Mailchimp for WordPress

Mailster - Email Newsletter Pluign
Metorik Helper

Ninja Forms

PixelYourSite Pro

Polylang

Quform WordPress Builder Plugin

W3 Total Cache

WP Fastest Cache

WP Job Manager

WP Rocket

WP SUPER CACHE

WPBakery Page Builder for WordPress
WPML - The WordPress Multilingual Plugin
WordPress Simple PayPal Shopping Cart
Wordfence Security

wpForo

Yoast SEO

There are thousands of plugins for WordPress, we can’t possibly include all the compatible ones in this list.

Don’t worry if you are using plugins not listed above. With our 30-day money back guarantee, you can try the plugin
risk-free and get a full refund if it doesn’t work with something else on your site.
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CHAPTER 7

Shortcodes

7.1 Plugin Shortcodes

7.1.1 [ultimate_gdpr_myaccount]

This shortcode will let you display Age Verification, Personal Data Access, Right to be Forgotten, Data Rectification
tabs and Unsubscribe.

PERSOMAL DATA ACCESS

Below, you can request for your personal data that's collected by this website sent to you in an email.

Email:

| consent to have my email collected in order to receive my requested data. See Privacy Policy page for more
information.

SUBMIT

7.1.2 [ultimate_gdpr_terms_accept]

This shortcode will let you add a button to accept the Terms and Conditions that is in the page. The options for this
shortcode could be changed in Ultimate GDPR & CCPA > Terms and Conditions.
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What third parties we receive data from

What automated decision making and/or profiling we do with user data

Industry regulatory disclosure requirements

7.1.3 [ultimate_gdpr_policy accept]

This shortcode will let you add a button to accept the Privacy Policy that is in the page. The options for this shortcode
could be changed in Ultimate GDPR & CCPA > Privacy Policy.

What third parties we receive data from

What automated decision making and/or profiling we do with user data

Industry regulatory disclosure requirements

7.1.4 [render_cookies_list]

This shortcode will let you show the cookies that are saved in Services Manager.

__utma, _utmb, _utmec, _utmt, _utmz, _ga, _gat, Analytik Third party  + Persistent
_gid
act, wd, xs, datr, s ser, Werbung Third party  + Persistent
reg_ext_ref, reg_{ ref

Funktionalitét Third party Persistent

km_ai, km_lv, km_vs, _atuvs, __atuvc, uv

You can also display the each cookie in a separate row by adding the parameter: dis-

play_single_cookies=true

Sample for the shortcode w/ parameter:

Chapter 7. Shortcodes
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Cookie List
Permalink: hitps://www.createit.pl/gdpr/cookie-list/ | Edit

Q] Add Media ||

b || i || link || b-quote || el ns || img u ol || li || code || more || close tags

[render cookies list display single cookies=true]|

Output:

Cookie List

Cookie names Type of First or Third Can be Session or Expiry Time Purpose
cookie party blocked Persistent
_utma Analytics Third party L Persistent
_utmb Analytics Third party v Persistent
__utmc Analytics Third party L Persistent
_utmt Analytics Third party L Persistent
_utmz Analytics Third party v Persistent
act Advertising Third party L Persistent
wd Advertising Third party L Persistent
x5 Advertising Third party ~ Persistent
datr Advertising Third party L Persistent
sb Advertising Third party v Persistent
presence Advertising Third party ~ Persistent
c_user Advertising Third party L Persistent
fr Advertising Third party v Persistent
p Advertising Third party ~ Persistent
reg_ext_ref Advertising Third party L Persistent

7.1.5 [ultimate_gdpr_cookie_popup]

This shortcode will let you create a link for the Advance cookie settings. You can add it any where on your site.
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INTRODUCTION

Loram ipsum dolor sit amet, consectetur adipisicing elit. Proin nibh augue, suscipit a, scelerisque sed, lacinia in, mi. Cras vel lorem.
Etiam pellentesque aliquet tellus. Phasellus pharetra nulla ac diam. Quisque semper justo at risus. Donec venenatis, turpis vel
hendrerit interdum, dui ligula ultricies purus, sed posuere libero dui id orci. Nam congue, pede vitae dapibus aliquet, elit magna
vulputate arcu, vel tempus metus lec non est. Etiam sit amet lectus guis est congus mellis. Phasellus congue lacus eg2t negue,
Phasellus ornare, ante vitae consectetuer consequat, purus sapien ultricies dolor, et mollis pede metus eget nisi. Pragsent sodales
velit gquis augue. Cras suscipit, urna at aliquam rhoncus, urna quam vivarra nisi, in interdum massa nibh nec erat.

COOKIE CONSENT LINK

GENERAL TERMS

Lorem ipsurm dolor =it amet, consectetur adipisicing lit. Proin nibh augue, suscipit &, scelerisque sed, lacinia in, mi. Cras vel
lorem. Etiam pellentesque aliquet tellus. Phasellus pharstra nulla ac diam. Quisque sermper Justo at risus. Donec venenatis,
turpis vel hendrerit interdum, dui ligula ultricies purus, sed posuere libero dui id orcl.

Mam congue, pede vitae dapibus aliquet, elit magna vulputate arcu, vel tempus metus lec non est. Etiam sit amet lectus quis est
congue mollis. Phasellus congue |acus eget neque. Phasellus ornare, ante vitae consectetuer conseguat, purus saplen ultricies delor,

RSP S (U RUS PN U | SN  PHY BN U S S S 1M NS S

7.1.6 [ultimate_gdpr_protection level=(1 to 4)]

This shortcode will hide any content in the shortcode unless the cookie group chosen by the user of the site will meet

the requirements of the shortcode.

This content requires cookies

OUR AGENTS

[#:Bob Doser [#2Kristine Black [#:Mia Gonzales [#2Robert 5. Morris

Robert 5. Morris

See properties

Bob Doser

See properties

Kristine Black Mia Gonzales

See properties See properties

L 123456789 . 123456789 . 123456789 . 123456789
0 888933000 0 888992000 0 888933000 0 888992000
] £4 ] £4

bob donser@exampleco

m

kristine black@examplec

om

miz.gonzales@examplec

om

roberts.morris@example

com
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7.1.7 [ultimate_gdpr_center myaccount_page=# contact_page=# icon_color=#]

This shortcode will create a page that have the Privacy tools in the site.

% Data Access ? Age Verification

& Right To Be Forgotten READMORE = = Data Rectification

! Unsubscribe READMORE 1= 'm' Cookie Settings

Privacy Policy READMORE = o Terms & Conditions Pages
& Contact DPO READMORE =

MORE =

MORE =

MORE 1=

MORE 1=

To get the # in myaccount_page=# in the shortcode, go to the page where you have added the [ulti-

mate_gdpr_myaccount] shortcode.

You use the post number of the page in the address bar of the page.

@ Mot secure _ sample/wp-admin/post.phpfpost=73Raction=edit

fites @4 sample ¢ Flatsome B Activate Theme 3 9 4+ Mew View Page

d

Edit Page Add New
Editor Builder

GDPR

permaiink: QU <"

03 Add Media

Formats ¥  Paragraph vB I £ E ¢ = £ £ & = o

[ultimate_gdpr_myaccount]

Shortcodes v

To get the # in contact_page=# in the shortcode, go to the page where you added the contact forms.

Same as the myaccount_page, you use the post number of the page in the address bar of the page.

For the icon_color=#, add the color code that you would like to use.

Sample of the shortcode:

7.1. Plugin Shortcodes
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Editor Builder

Privacy Center

Permalink: D - rivacy-center/ Edit

Q7 Add Media Visual ~ Text

Formats ¥ = Paragraph v B I = = ¢ & = o

Shortcodes «

[ultimate_gdpr_center myaccount_page=73 contact_page=86 icon_color=#e03131]

Word count: 0 Last edited by createit on August 17, 2018 at 7:56 am
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CHAPTER 8

FAQs

8.1 Plugin

8.1.1 Why are some plugins are not compatible with GDPR & CCPA plugin?

There are thousands of plugins that are available for Wordpress, one or more plugins have a chance to conflict with
Ultimate GDPR & CCPA.

To know how to troubleshoot plugin conflicts, read this part of the documentation:

* Incompatible with Plugins

8.2 3rd Party Cookies

8.2.1 What are third-party cookies?
In “third-party cookie”, the word “party” refers to the domain as specified in the cookie; the website that is placing the
cookie.

So, for example, if you visit example.com and the domain of the cookie placed on your computer is example.com, then
this is a first-party cookie.

If, however, you visit example.com and the cookie placed on your computer says some-other-site.com, then there are
third-party cookies generated.
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Storage

[ |:|_ Elements Console Sources Metwork Performance Application
Application c e Filter
B Manifest Mame Value Do. |P..|Exp.
o g \Workers _cfduid |dd3bObc330cba.., | taw.. |/ |201.
W Clear storage B JkTxTpéfa vada.. |/ | 196...
fawkl.. | ZGdE3vTgsQ5e2F.. | vata. [/ | 201,

»

8.3 Blocking Cookies

8.3.1 Why are some cookies not Blocked?

These are some of the reasons why this happens:

¢ User have visited the site before the plugin was activated.

We don’t want to block all the cookies since the user already interacted with the site.

These cookies are saved in the users computer and could be removed by clearing the computer’s

cache history.

Elements

Console  Sources

c e
Name
MD

ULTIMATE GDPR
PLUGIN

vip-setting..

Frames

*Dtop

Get to know the Ultimate GDPR
with our video tutorial

Network

TewkConm.., |0
_clduid
_taukuid

Performance

Value
134=REupsFi0lceaY.

d431f01¢59dgefed... |... |/

encreateit plaUrixld

Application  »

* Cookie is essential for the site to work. (example: PHP session)

These are cookies that are needed for your site to work properly. These cookies are usually added in

the cookie whitelist.
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To know more about Cookie Whitelist, read this part of the documentation.

& al Elements  Console  Sourcss  Metwork  Performance  Application % PoX
Application e

B Manifest Name | Value Do.. |,
C. Wiaee

area.. |/

s |/

gid | GA12.84494092... |.crea.. |/ |2

ULTIMATE GDPR = .
PLUGIN @ nttps/fvataikio

Get to know the Ultimate GDPR

with our video tutorial

¢ The cookie is a ‘““third party” type.

Opposite to a “first party” cookie, a “third party” cookie couldn’t be block using standard program-
matical methods.

The only way to do it is to prevent the script that is adding the cookie from initializing.

We’re trying to find ways to do so, but there are some rare occasions that it isn’t possible/difficult to
block such scripts.

& 4 Elements  Console  Sources  Metwork  Performance  Application  » HE'Y
c e

name value e[| B [Su [ur [Sen [
_cfduid
E i
tawkUUID | Ze

ULTIMATE GDPR
PLUGIN

Get to know the Ultimate GDPR &S
with our video tutorial

You can read more information about third party cookies here.

— The cookies are created by other plugins that are not integrated with Ultimate GDPR &
CCPA.

Cookies that are generated by the active plugins in the site.
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Application c ® Filter
. Manifest MName Value Do.. | |[E7 e || & e Bt || 5
£X Service Workers _ cfduid | dd3bSbc330db8.., |taw.. |/ [201..| 51
— [ jkT«TpEfa vata. |/ 196.. | 11| & | &

Service Workers

tawkl... | Z2GdE3vTgsQ%e2F.. |vata. |/ | 201.. | 83| « | &

)
[=]
2

=]
m

ocal Storage

* ¥
m m

[T

ession Storage

E

=

= b

B WebSaL

Cache
B Cache Storag
& Cache Storage

&8 Application Cache

Frames

8.3.2 Why is the Cookie Consent always visible even after consent is given?

Some factors may affect the cookie consents even after consent is already accepted.
These are some of the factors:

* Due to caching plugin/caching module enabled in the server.

* Server PHP version

* Javascript error on the site

For more details, read this part of the documentation

8.3.3 How to remove cookies that are generated before plugin is installed?
It’s not always possible to remove existing cookies. For example “third-party”” cookies cannot be removed program-
matically. The only way to “block” them is to prevent them from creating.

Users can also remove them manually, by going to the browser settings and clear cookies there (users can also use
CTRL + Shift + Delete shortcut to open the browser settings for clear cookies).
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Clear browsing data

Advanced

Browsing history
17 items

(<

Download history
MNone

(<

Cookies and other site data
From 27 sites

(<

Cached images and files
Less than 638 MB

(<

Passwords
Mone

(<

Autofill form data
Mone

(<

Cancel Clear data

-

8.4 Cookie Groups

8.4.1 Why is the Cookies Groups incremental?

The Cookie Groups for Ultimate GDPR & CCPA are cookie levels, where you would need to pass level 1 to get to
level 2. This will allow tracking of only the necessary cookies or possible cookies.

You can customize the cookie groups as you see fit. You can disable, rename, add/remove cookies, etc., the cookie

group of your choice.

Read these parts of the documentation for:

* Cookie Groups

8.4. Cookie Groups
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8.5 Cookie Scanner

8.5.1 Why is it that No Cookies are Found when using Cookie Scanner?

There are few reasons why the scanner might not working on the website. Please make sure that:
* The website the Cookie Scanner is used on is publicly accessible, otherwise, the scanner can’t access the website.

* From version 2.0.0 of the plugin, the Cookie Scanner feature won’t work until license code won’t be added in
the correct field of the plugin.

8.5.2 Why is it that Not All Cookies are Found on my site?

The Cookie scanner is mimicking the site’s user, which is surfing the website.
What the user is doing, accessing, or loading in the site will affect the amount of cookies that are in the site.
In these rare situations, cookie scanner cannot detect the cookie, for example:

* A particular cookie is added not on page load, but later.

A particular cookie is added after user somehow interact with the site (clicking on the link, submitting the form,
etc).

To learn more about how to block cookies, read this part of the documentation.

8.5.3 Why plugin is asking for my license code?

From version 2.0.0 of the plugin, the Cookie Scanner functionality won’t be available until a valid Envato license key
will be provided.

To be allowed to use the Cookie Scanner, please go from the WordPress dashboard to Ultimate GDPR & CCPA >
License or click the link available in the dashboard message.

[Ultimate GDPR] Your license key is missing, add valid purchase code to use the cookie scanner

There you will find a field in which you need to enter your license key.
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[fultimate_gdpr_protection]

Privacy Center: [ultimate_gdpr_center myaccount_page=15
contact_page=18 icon_color=#e03131]

Ultimate GDPR

Cockie Consent

Services Manager

Age Verification License
Terms And Conditions
Privacy Policy

Envato key
Right To Be Forgotten
Data Access

Don’t know where to find your license key? Please follow the instruction under this link.

8.6 Google Analytics Stats

8.6.1 What if | have a Cookie Scanner Issue?

Our cookie scanner is using parameters to access the site and find the lists of cookies that site are using.

To prevent Google Analytics from counting stats for ?ctpass=1 requests, just use Google Analytics IP address filter
To know how to create an IP address filter, click here.

8.6.2 How to use Google Tag Manager?

Using the Google Tag Manager to manage your Google Analytics makes it faster and easier.

Note: Install Google Tag Manager first in your site so that it can monitor the sites activity.

In the Tag Manager, create the Tag for Google Analytics. You can use a pre-existing Google Analytics ID.
By using Google Tag Manager, you can customize how Google Analytics behave in your site.

For information on how to install and setup Google Tag Manager, click here.

8.7 Other Issues

8.7.1 Why is the plugin slowing down the site?
Plugin includes experimental feature Pseudonymization. Which is encrypting user data in database, then on page
load user data is decrypted.

This type of functionality can require some server resources. If you see higher load on server, we recommend to
disable Pseudonymization.
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